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1 GETTING STARTED
Cameo Business Modeler is a tool that provides a solution for modeling and analyzing business processes. This 
tool allows you to represent and analyze business process models based on the Business Process Modeling and 
Notation (BPMN) standard, define organization structure and business data as well as business motivation based 
on Business Motivation Model (BMM) standard.

This chapter contains the following sections:

• Introducing Main Concepts

• Installing Cameo Business Modeler Plugin

• Switching to Business Modeling Perspectives

• Creating BPMN Projects

1.1 Introducing Main Concepts
This chapter contains the following sections:

• Business Process Model and Notation (BPMN) standard

• Business Motivation Model standard

• Supportive Diagrams

1.1.1 Business Process Model and Notation (BPMN) standard

The Business Process Modeling and Notation is a standard created by the Object Management Group (OMG). 
BPMN provides the capability of describing internal business procedures in a graphical notation and enables 
organizations to communicate these procedures in a standard manner. Furthermore, the standardized graphical 
notation facilitates the understanding of performance collaborations and business transactions between 
organizations. This ensures that businesses will understand themselves and other business participants better.

The Cameo Business Modeler plugin for MagicDraw provides support for BPMN2 standard, business concepts 
and organization structure definition, and BMM standard support for business goals definition. It is also includes 
BPMN model validation, business analysis tables, matrices, relation maps, reports, manuals, samples, and imports 
from BPMN 1.1 models that have been created with MagicDraw.

Cameo Business Modeler provides capabilities for model exchange via XPDL files import and export, BPMN2 XMI 
export.

The BPMN2 standard consists of the following three major parts:

• Process, which shows business processes, events, and messages. 

• Collaboration, which shows how a process is implemented among collaborators and displays 
details of conversations among participants. 

• Choreography, which provides a view of message/information flows among participants.

The following diagrams are supported:

• BPMN Process Diagram

• BPMN Collaboration Diagram
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Installing Cameo Business Modeler Plugin
• BPMN Choreography Diagram

1.1.2 Business Motivation Model standard

The Business Motivation Model (BMM) is a standard created by the Object Management Group (OMG). This 
standard is designed to develop, communicate, and manage business plans. The model identifies and defines the 
elements of business plans, the motivating factors to establish the business plans, and how all these factors and 
elements are interconnected.

You can find full details about BMM at http://www.omg.org/technology/documents/br_pm_spec_catalog.htm

The following diagrams are supported:

• Business Motivation Diagram

1.1.3 Supportive Diagrams

Cameo Business Modeler also supports diagrams that allow for specifying additional information about business 
model.

The following diagrams are supported:

• Process Definition Diagram

• Business Data Diagram

• Organization Structure Diagram

1.2 Installing Cameo Business Modeler Plugin
You can install the Cameo Business Modeler plugin in one of the following ways:

• Use the Resource/Plugin Manager window in MagicDraw to download and install the plugin.

• Follow the manual installation instructions if direct download through the Resource/Plugin 
Manager window is not available or if you have already downloaded the plugin.

To install the Cameo Business Modeler plugin using the Resource/Plugin Manager window

1. On the MagicDraw main menu, click Help > Resource/Plugin Manager. The Resource/Plugin 
Manager window will open and prompt you to check for the latest tool updates and resources. 
Click Check for Updates. The Question dialog will open.

2. Click Check.

3. Click to select the Cameo Business Modeler check box and click Download/Install.
4. Restart MagicDraw.

To install the Cameo Business Modeler plugin manually on all operating systems

1. Close MagicDraw.
2. Download the Cameo_Business_Modeler_Plugin_<version number>.zip file.
3. Extract the file to the directory wherein your MagicDraw is installed.

Specify HTTP Proxy Settings for the connection to start MagicDraw 
UML updates and resources.
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Switching to Business Modeling Perspectives
4. Start MagicDraw.

Related external resource
“Resource Manager” in MagicDraw UserManual.pdf

1.3 Switching to Business Modeling Perspectives
The business modeling perspectives are dedicated to business process modelers. The perspectives offer a 
simplified user interface by showing the features that are relevant to business process modeling and hiding the 
others that are not.

Cameo Business Modeler offers two business modeling perspectives. They are as follow: 

• Business Analyst perspective that provides set of most often used elements of BPMN standard.

• Business Architect perspective that provides all BPMN elements.

To switch to the Business Analyst or Business Architect perspective

1. From the main menu, click Options > Perspectives > Perspectives. The Select Perspectives 
dialog will open.

2. Select Business Analyst or Business Architect appropriately and click Apply.

Related external resource
“Customizing and Selecting Perspective” in MagicDraw UserManual.pdf.

1.4 Creating BPMN Projects
To create a new project from template, you can choose one of the following templates:

• A BPMN2 Project, which provides the workspace for business process modeling. This project is 
empty.

• A Business Model project, which provides workspace with predefined project structure and 
guidelines how to create business model.

• BPMN2 - SoaML project, which provides a workspace for business architecture modeling using 
BPMN2 and SoaML standards.

When you install the plugin, you will automatically get an evaluation key, 
which is valid for seven (7) days. Afterwards, you will need to purchase 
a license for the plugin to work with business modeling diagrams (once 
the evaluation license has expired, business modeling diagrams will be 
in read-only mode).

To use the BPMN2-SoaML template for a new project, you must have 
the Cameo SOA+ plugin installed. Use the Resource Manager window 
to install the plugin. For more information, see “Resource Manager” in 
MagicDraw UserManual.pdf.
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Creating BPMN Projects
1.4.1 Creating Empty Business Model

To create a new workspace for an empty project

1. Do one of the following:
• On the main menu, click File > New Project.
• Click the  button on the File toolbar.

• Press Ctrl + N.

2. In the New Project dialog, select the project template under the Business Process Modeling 
domain.

3. Specify the file name in the Name box.
4. Click the ... button to define the location for storing your newly created project in your computer.
5. Click OK.

Related external resource
“Working with Projects” in MagicDraw UserManual.pdf

If you work not in the Business Analyst perspective, a message asking whether 
you want to change the perspective will open. Click Yes to switch to the 
Business Analyst perspective supporting business modeling diagrams.
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2 BUSINESS PROCESS MODEL 
AND NOTATION CONCEPTS
This chapter contains the following sections:

• Common BPMN Elements

• BPMN Process Diagram

• BPMN Collaboration Diagram

• BPMN Choreography Diagram

• Numbering Elements

• XPDL Support

• BPMN2 XML support

2.1 Common BPMN Elements
The following section defines the BPMN elements that can be used in several BPMN diagrams, such as Process, 
Collaboration, and Choreography diagrams.

Common BPMN2 elements are described in the following sections:

• Definitions

• Artifacts

• Error

2.1.1 Definitions

Description
The Definitions element is a root model in a business modeling project. This element is the outermost containing 
object for all BPMN elements. It defines the visibility scope and the namespace for all of the BPMN elements in a 
model.

Example

Figure -- Definitions element in Containment tree
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Common BPMN Elements
2.1.2 Artifacts
Artifacts provide modelers with the capability to show additional information about a process.

Types of Artifacts are as follows:

• Anchor

• Association

• Group

• Text Annotation

2.1.2.1 Anchor

Description
An Anchor is used to associate a Text Annotation, Note, or Comment with the other diagram elements.

Example

Figure -- Anchor associating Text Annotation with Activity

Related element
Text Annotation

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related external resource
“Note” and “Comment” in MagicDraw UserManual.pdf

2.1.2.2 Text Annotation

Description
A Text Annotation allows a modeler to provide additional information about elements for the reader of a BPMN 
diagram.

This information is not directly related to a sequence 
or message flow of the process.
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Common BPMN Elements
Example

Related element
Anchor

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

2.1.2.3 Association

Description
An Association relation can be drawn between any BPMN elements.

This element also can denote an Activity that is used for a Compensation.

Notation

Figure -- Association from Compensation Boundary Event to Compensation task

Related element
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

2.1.2.4 Group

Description
A Group element represents an informal visual grouping of the diagram graphical elements.

A group shows all elements that belong to the same category. This type of grouping does not affect a sequence 
flow within the Group. A category name appears on the diagram as a Group label.
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BPMN Process Diagram
Example

Figure -- Group showing elements in same category

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

2.1.3 Error

Description
An Error represents the content of an error event or the fault of a failed operation. An Error is generated when 
there is a critical problem in the processing of an Activity or when the execution of an operation fails.

Related elements
Start Events
Boundary Events
End Events

2.2 BPMN Process Diagram
Description
A BPMN Process Diagram describes a sequence or flow of activities in an organization that shows how the 
business works. The diagram shows activities, events, and data that trigger or feed business activities. A BPMN 
Process Diagram is similar to the UML Activity diagram with a much richer set of default message types and 
business process styles of notations.
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BPMN Process Diagram
Example

Figure -- BPMN Process diagram

Related element
BPMN Process

Related procedure
Creating BPMN Process Diagram

2.2.1 BPMN Process

Description
A BPMN Process element defines a process performed in an organization. This element is a container for the 
BPMN Process diagram and its elements. Process diagram describes how a process is performed.

Notation

Related element
Tasks

Related diagram
Process Definition Diagram

2.2.2 Activities
An Activity is a work that is performed within a business process. An Activity can be atomic or non-atomic 
(compound). There are three types of Activities that are part of a Process:

• Tasks

• SubProcesses

• Call Activity
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BPMN Process Diagram
If the Activity property Is For Compensation is set to true, the Activity will be used for compensation, which means 
that this Activity will be activated only when a Compensation Event is detected and initiated under the 
Compensation Event visibility scope. The Compensation indicator (marker) is displayed for all activities that are 
used for the compensation.

• Compensation Task with Compensation indicator

• Compensation SubProcess with Compensation indicator

Activities can be repeated sequentially, essentially behaving like a loop. The presence of loop characteristics 
signifies that an Activity has the looping behavior. There are two types of looping characteristics defined in BPMN: 

• Standard Loop 
A Standard Loop indicator (marker) displayed in an Activity shape shows that the looping behavior 
based on a boolean condition is defined for this Activity. Additional looping characteristics can be 
defined, and the Activity will loop as long as the boolean condition is true. The condition is 
evaluated for every loop iteration and can be evaluated at the beginning or end of the iteration. In 
addition, a numeric cap can be optionally specified, but the number of iterations cannot exceed 
this cap.

• Task with Standard Loop marker

• SubProcess with Standard Loop marker

• MultiInstance Loop
A MultiInstance Loop indicator shows that a desired number of Activity instances can be created. 
The instances can be executed in parallel or sequentially. Either expression is used to specify the 
desired number of instances or a data driven setup that can be used.

• Task with MultiInstance Loop marker for parallel instances

• SubProcess with MultiInstance Loop marker for parallel instances

• Task with MultiInstance Loop marker for sequential instances
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BPMN Process Diagram
• SubProcess with MultiInstance Loop marker for sequential instances

Related procedure
Using Activities

2.2.2.1 Tasks
A Task is an atomic Activity within a process flow. A Task is used when the work in a process cannot be broken 
down into finer levels of detail. Generally, an end-user and/or application are used to perform the task when it is 
executed. Types of Tasks used in business process modeling are as follows:

• Task

• Service Task

• Send Task

• Receive Task

• User Task

• Manual Task

• Business Rule Task

• Script Task

2.2.2.1.1 Task

Description
A Task that has no specified behavior defined.

Notation

Related elements
Activities
Service Task
Send Task
Receive Task
User Task
Manual Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

The Compensation, Multi-instance Loop, and Standard Loop indicators can be added 
to all types of Activities.
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BPMN Process Diagram
Related procedure
Creating and Using Tasks

2.2.2.1.2 Service Task

Description
A Service Task is a task that uses some sort of service, which could be a Web service or an automated 
application.

Notation

Related elements
Activities
Task
Service Task
Receive Task
User Task
Manual Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.1.3 Send Task

Description
A Send Task is a simple task that is designed to send a message to an external participant. Once the message 
has been sent, the task is completed.

Notation

Related elements
Activities
Task
Service Task
Receive Task
User Task
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BPMN Process Diagram
Manual Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.1.4 Receive Task

Description
A Receive Task is a simple task that is designed to wait for a message to arrive from an external participant 
(relative to the Process). Once the message has been received, the task is completed.

Notation

Related elements
Activities
Task
Service Task
Send Task
User Task
Manual Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.1.5 User Task

Description
A User Task is a typical workflow task where a human performer performs the task with the assistance of software 
and is scheduled through a task list manager of some sort.

Notation
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BPMN Process Diagram
Related elements
Activities
Task
Service Task
Send Task
Receive Task
Manual Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.1.6 Manual Task

Description
A Manual Task is a task that is expected to be performed without the aid of any business process execution engine 
or application, for example, installing a telephone at a customer location.

Notation

Related elements
Activities
Task
Service Task
Send Task
Receive Task
User Task
Business Rule Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks
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BPMN Process Diagram
2.2.2.1.7 Business Rule Task

Description
A Business Rule Task provides a mechanism for a process to provide inputs to a business rules engine and to get 
the output of calculations that the business rules engine might provide.

Notation

Related elements
Activities
Task
Service Task
Send Task
Receive Task
User Task
Manual Task
Script Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.1.8 Script Task

Description
A Script Task is executed by a business process engine. A modeler or an implementer defines a script in a 
language that the engine can interpret. When the task is ready to start, the engine will execute the script. When 
the script is completed, the task will also be completed.

Notation

Related elements
Activities
Task
Service Task
Send Task
Receive Task
User Task
Manual Task
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BPMN Process Diagram
Business Rule Task

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Tasks

2.2.2.2 SubProcesses
A SubProcess is an Activity whose internal details have been modeled using activities, gateways, events, and 
sequence flows. A SubProcess is a graphical object within a process. It can be “opened up” to show a lower-level 
process. SubProcesses define a contextual scope that can be used for attribute visibility and a transactional scope 
for the handling exceptions of Events or for compensation.

A collapsed view of a SubProcess hides its details while an expanded view shows its content. A collapsed 
SubProcess uses a plus sign (+) to distinguish itself from a Task.

Different types of SubProcesses used in business process modeling are as follows:

• SubProcess

• AdHoc SubProcess

• Event SubProcess

• Transaction

2.2.2.2.1 SubProcess

Description
A SubProcess is used to create a context for an exception handling that applies to a group of activities.

A collapsed SubProcess can be used as a mechanism to show a compact and less clutter group of parallel 
activities.

Notation
• Expanded SubProcess

• Collapsed SubProcess
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BPMN Process Diagram
Example

Figure -- Expanded SubProcess

Related elements
Activities
AdHoc SubProcess
Event SubProcess
Transaction

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using SubProcesses

2.2.2.2.2 AdHoc SubProcess

Description
An AdHoc SubProcess is a specialized type of SubProcess, which is a group of activities that have no required 
sequence relationships. A set of activities can be defined for the process, but the sequence and number of 
performances for the activities are determined by the performers of the activities.

Notation
• Expanded

• Collapsed
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BPMN Process Diagram
Related elements
Activities
SubProcess
Event SubProcess
Transaction

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using SubProcesses

2.2.2.2.3 Event SubProcess

Description
An Event SubProcess is an ordinary SubProcess whose Triggered By Event property is set to true. It is not a part 
of a normal flow of its parent process - there is no incoming or outgoing sequence flow. 

An Event SubProcess may occur many times. Unlike the standard SubProcess that uses the flow of the parent 
process as a trigger, it has a Start Event as a trigger. Whenever the Start Event is triggered while the parent 
process is active, the Event SubProcess will start.

The Start Event icon of a collapsed Event SubProcess will be displayed on the top left corner of the SubProcess.

Notation
• Expanded

• Collapsed

• Collapsed (with its own Start Event)

Related elements
Activities
SubProcess
AdHoc SubProcess
Transaction
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
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BPMN Process Diagram
Related procedure
Creating and Using SubProcesses

2.2.2.2.4 Transaction

Description
A Transaction is a specialized type of SubProcess whose special behavior is controlled through a transaction 
protocol (such as WS-Transaction).

Notation
• Expanded

• Collapsed

Related elements
Activities
SubProcess
AdHoc SubProcess
Event SubProcess

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

2.2.2.3 Call Activity

Description
A Call Activity identifies a point in a process where a global process is used. The Call Activity acts as a wrapper for 
the invocation of the global process within the execution. The activation of the Call Activity results in the transfer of 
control to the called global process.

A Call Activity shares the same notation as a Task or SubProcess with a thick line around the boundary of its 
shape.

The BPMN2 Call Activity corresponds to the Reusable SubProcess of BPMN 1.2, and the BPMN2 SubProcess 
corresponds to the Embedded SubProcess of BPMN 1.2.

Notation
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BPMN Process Diagram
Example

Figure -- Call Activities Referencing Process

Related elements
BPMN Process
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

2.2.3 Sequence Flow

Description
A Sequence Flow is used to show the order of flow elements in a process or a choreography.

The source and target of a Sequence Flow must be from a set of the following elements:

• Events (Start, Intermediate, and End events)

• Activities (Task and SubProcess for Processes)

• Choreography Activities (Choreography Task and Sub-Choreography)

• Gateways

A Sequence Flow can optionally define a condition expression indicating that a token will be passed down the 
Sequence Flow only if the expression is evaluated to be true.

A Condition expression is typically used when the source of a Sequence Flow is a Gateway or an Activity. A 
conditional outgoing Sequence Flow from an Activity is with a mini-diamond (indicator) at the beginning of the 
Sequence Flow.

A Sequence Flow, which has an exclusive, inclusive, or complex gateway, or an Activity as its source, can also be 
defined as a default Sequence Flow. The default Sequence Flow is represented with a backslash.

A default Sequence Flow will be taken (a token is passed) only if all of the other outgoing Sequence Flows from an 
Activity or Gateway are not valid, meaning that their condition expressions are false.

Example

Figure -- Sequence Flow between two Tasks

A Conditional Sequence Flow outgoing from a Gateway does not have 
a mini-diamond at the beginning of the Sequence Flow.
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BPMN Process Diagram
Figure -- Conditional Sequence flow

Figure -- Default Sequence Flow

Related elements
Start Events
Intermediate Catch Event
Intermediate Throwing Event
End Events
Task
SubProcess
Choreography Task
SubChoreography
Gateways

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Process Diagram

2.2.4 Start Events
A Start Event indicates where a particular process starts. In terms of sequence flows, a Start Event starts the flow 
of a process, and thus cannot have any incoming sequence flows.

When a Start Event is owned by an Event SubProcess, it can be:

• Interrupting. The Start Event interrupts the process contained in the Event SubProcess. The 
Interrupting Message Start Event is drawn with a solid border.

• Non-Interrupting. The Start Event does not interrupt the process contained in the Event 
SubProcess and starts parallel flow. The Interrupting Message Start Event is drawn with a dashed 
border.

Types of Start Events are as follows:
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• None Start Event

• Message Start Event

• Timer Start Event

• Compensation Start Event

• Conditional Start Event

• Escalation Start Event

• Error Start Event

• Signal Start Event

• Multiple Start Event

• Parallel Multiple Start Event

2.2.4.1 None Start Event

Description
A None Start Event does not have a defined trigger that invokes the start of a process.

Notation

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.2 Message Start Event

Description
A Message Start Event means that a message from a participant has arrived and triggered the start of a process. 

A Message Start Event displays any of the following on a diagram: 

• A Message Start Event name if the name is specified.

• A Message Ref property value if the name is unspecified.

• An Operation Ref property if the name and Message Ref are not specified.

Notation
• Interrupting Message Start Event

• Non-interrupting Message Start Event
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Related elements
Start Events
Message

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.4.3 Timer Start Event

Description
A Timer Start Event allows a particular time and date or cycle setting, for example, on Mondays at 9 A.M., to 
trigger the start of a process. 

A Timer Start Event displays any of the following on a diagram:

• A Timer Start Event name if the name is specified.

• A Time Cycle property name if the name is unspecified.

• A Time Date property if the name and Time Cycle are unspecified.

Notation
• Interrupting Timer Start Event

• Non-interrupting Timer Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.4 Compensation Start Event

Description
A Compensation Start Event triggers an in-line Compensation Event SubProcess only. The event is triggered 
when the compensation occurs.

Notation
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Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.5 Conditional Start Event

Description
A Conditional Start Event is triggered when a condition is specified, become true. For example, “S&P 500 changes 
by more than 10% since opening” or “Temperature above 300C”.

A Conditional Start Event displays either of the following on a diagram:

• A Conditional Start Event name if the name is specified.

• A Condition property value if the name is unspecified.

Notation
• Interrupting Conditional Start Event

• Non-interrupting Conditional Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.6 Escalation Start Event

Description
An Escalation Start Event implements measures to expedite the completion of a business Activity.

This event displays either of the following on a diagram:

• An Escalation Start Event name if the name is specified.

A conditional expression of an event must become “false”, and then “true” 
before the event can be triggered again.
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• An Escalation Code property value if the name is unspecified.

Notation
• Interrupting Escalation Start Event

• Non-interrupting Escalation Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.7 Error Start Event

Description
An Error Start Event triggers an in-line Event SubProcess only.

This event displays either of the following on the diagram:

• An Error Start Event name if the name is specified.

• An Error Ref property value if the name is unspecified.

Notation

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.4.8 Signal Start Event

Description
A Signal Start Event means that a signal, which has been broadcast from another process, has arrived and 
triggered the start of a process. 

An Escalation Start Event triggers an in-line Event SubProcess only.
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A Signal Start Event displays either of the following on a diagram:

• A Signal Start Event name if the name is specified.

• A Signal Ref property value if the name is unspecified.

Notation
• Interrupting Signal Start Event

• Non-Interrupting Signal Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.4.9 Multiple Start Event

Description
A Multiple Start Event indicates that there are multiple ways to trigger a process. However, only one is required. 

Notation
• Interrupting Multiple Start Event

• Non-interrupting Multiple Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event
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2.2.4.10 Parallel Multiple Start Event

Description
A Parallel Multiple Start Event indicates that there are multiple triggers required before a process can be initiated.

Notation
• Interrupting Parallel Multiple Start Event

• Non-Interrupting Parallel Multiple Start Event

Related element
Start Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.5  Intermediate Catch Event
An Intermediate Catch Event indicates that something is happening between the start and end of a process. 
Intermediate Events affect the flow of a process, but do not start or directly terminate the process.

You can use Intermediate Catch Event to: 

• Show where messages are expected or sent within a process.

• Show delays that are expected within a process.

• Interrupt normal flow through exception handling.

Types of Intermediate Catch Events are the following:

• None Intermediate Event

• Message Catching Intermediate Event

• Timer Catching Intermediate Event

• Conditional Catching Intermediate Event

• Link Catching Intermediate Event

• Signal Catching Intermediate Event

• Multiple Catching Intermediate Event

• Parallel Multiple Catching Intermediate Event

2.2.5.1 None Intermediate Event

Description
A None Intermediate Event does not have a defined trigger. 

This event is used to model methodologies that use events to indicate some changes in a state of process.
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Notation

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.2 Message Catching Intermediate Event

Description
A Message Catching Intermediate Event is used to receive a message. 

This event causes a process to continue if it is waiting for the message.

A Message Catching Intermediate Event displays any of the following on a diagram:

• A Message Catching Intermediate Event name if the name is specified.

• A Message Ref property value if the name is unspecified.

• An Operation Ref property if the name and Message Ref are not specified.

Notation

Related elements
Message
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.5.3 Timer Catching Intermediate Event

Description
A Timer Catching Intermediate Event acts as a delay mechanism based on a particular time and date, or cycle, for 
example, on Mondays at 9 A.M.

This Event displays any of the following on a diagram:

• A Timer Catching Intermediate Event name if the name is specified.

• A Time Cycle property name if the name is unspecified.

• A Time Date property if the name and Time Cycle are unspecified.
Copyright © 2009-2015 No Magic, Inc.                                                                                                                                                  35



BPMN Process Diagram
Notation

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.4 Conditional Catching Intermediate Event

Description
A Conditional Catching Intermediate Event is triggered when a condition becomes true.

This event displays either of the following on a diagram:

• A Conditional Catching Intermediate Event name if the name is specified.

• A Condition property value if the name is unspecified.

Notation

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.5 Link Catching Intermediate Event

Description
A Link Catching Intermediate Event provides the capability to connect two sections of a process. You can use this 
event to either:

• Create looping situations or to avoid long sequence flow lines, as “Off-Page Connectors” to print a 
Process across multiple pages, or as generic Go To objects within a Process level.

• Catch a link from a Link Throwing Intermediate Event.

You can only use one Link Event for each single Process level, meaning that it cannot link a parent Process with a 
SubProcess.

A Link Catching Intermediate Event displays either of the following:
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• A Link Catching Intermediate Event name if the name is specified.

• A Source property value if the name is unspecified.

Notation

Example

Figure -- Link Catching Intermediate Event

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.6 Signal Catching Intermediate Event

Description
A Signal Catching Intermediate Event is used to receive a signal. 

This event displays either of the following on the diagram:

• A Signal Catching Intermediate Event name if the name is specified.

• A Signal Ref property value if the name is unspecified.

Signals in business process modeling are used for general communications within and across process levels.

Notation

Related element
Intermediate Catch Event
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.7 Multiple Catching Intermediate Event

Description
A Multiple Catching Intermediate Event signifies that multiple types of events can be caught. Only one of the 
defined event triggers is required.

Notation

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.5.8 Parallel Multiple Catching Intermediate Event

Description
A Parallel Multiple Catching Intermediate Event signifies that multiple types of events are caught. All of the defined 
event triggers are required to trigger this event.

Notation

Related element
Intermediate Catch Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event
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2.2.6 Intermediate Throwing Event
An Intermediate Throwing Event indicates that something is happening between the start and end of a process. 
Intermediate Events affect the flow of a process, but do not start or directly terminate the process.

You can use Intermediate Throwing Events to show extra work required.

Types of Intermediate Throwing Events are as follows:

• Message Throwing Intermediate Event

• Link Throwing Intermediate Event

• Signal Throwing Intermediate Event

• Compensation Throwing Intermediate Event

• Escalation Throwing Intermediate Event

• Multiple Throwing Intermediate Event

2.2.6.1 Message Throwing Intermediate Event

Description
A Message Throwing Intermediate Event is used to send a message.

This Event displays any of the following on a diagram:

• A Message Throwing Intermediate Event name if the name is specified.

• A Message Ref property value if the name is unspecified.

• An Operation Ref property if the name and Message Ref are not specified.

Notation

Related element
Intermediate Throwing Eventt

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.6.2 Link Throwing Intermediate Event

Description
A Link Throwing Intermediate Event is used to throw a link to a Link Catching Intermediate Event.

This event displays either of the following:

• A Link Throwing Intermediate Event name if the name is specified.

• A Target Link Event property value if the name is unspecified.

Notation
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Related element
Intermediate Throwing Eventt

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.6.3 Signal Throwing Intermediate Event

Description
A Signal Throwing Intermediate Event is used to send a signal.

This event displays either of the following on a diagram:

• A Signal Throwing Intermediate Event name if the name is specified.

• A Signal Ref property value if the name is unspecified.

Notation

Related element
Intermediate Throwing Eventt

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.6.4 Compensation Throwing Intermediate Event

Description
A Compensation Throwing Intermediate Event indicates that a compensation is necessary.

If an Activity, which has been successfully completed, is identified, then it will be compensated.

If no Activity is identified, all successfully completed Activities visible from a Compensation Throwing Intermediate 
Event will be compensated in reverse order of their sequence flows. To be compensated, the Activity must have a 
Boundary Compensation Event or contain a Compensation Event SubProcess.

Notation

Related elements
Compensation
Intermediate Throwing Event
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.6.5 Escalation Throwing Intermediate Event

Description
An Escalation Throwing Intermediate Event raises an Escalation.

This event displays one of the following on the diagram:

• An Escalation Throwing Intermediate Event name if the name is specified.

• An Escalation Code property value if then name is unspecified.

Notation

Related element
Intermediate Throwing Eventt

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.6.6 Multiple Throwing Intermediate Event

Description
A Multiple Throwing Intermediate Event signifies that multiple types of events are thrown. All of the defined 
triggers will be thrown by this event.

Notation

Related element
Intermediate Throwing Eventt

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event
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2.2.7 Boundary Events
A Boundary Event is an Intermediate event which can be placed on the boundary of any of the following activities:

• SubProcess, Task, or Call Activity

• SubChoreography, Choreography Task, or Call Choreography

Boundary Event indicates that while attached-to Activity is running, event is listening for the trigger signal.

Boundary Event types:

• Interrupting Boundary Event aborts Activity and Process is continued of exceptional flow. This 
event is drawn with a solid border.

• Non-Interrupting Boundary Event splits process to parallel flows. This event is drawn with a 
dashed border.

Figure -- Error Boundary Event attached to SubProcess

Types of Boundary Events are as follows:

• Message Boundary Event
• Timer Boundary Event
• Escalation Boundary Event
• Error Boundary Event
• Cancel Boundary Event
• Compensation Boundary Event
• Conditional Boundary Event
• Signal Boundary Event
• Multiple Boundary Event
• Parallel Multiple Boundary Event

2.2.7.1 Message Boundary Event

Description
A Message Boundary Event is triggered by an arrived message. Once triggered, it changes a normal flow into an 
exception flow or parallel. 

A Message Boundary Event displays any of the following on the diagram:

• A Message Boundary Event name if the name is specified.

• A Message Ref property value if the name is unspecified.

• An Operation Ref property if the name and Message Ref are not specified.

Notation
• Interrupting Message Boundary Event

• Non-interrupting Message Boundary Event
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Related elements
Boundary Events
Activities
Message

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.2 Timer Boundary Event

Description
A Timer Boundary Event, which is attached to the boundary of an Activity, change a normal flow into an exception 
flow upon being triggered. A particular time-date or cycle, for example, on Mondays at 9 A.M., can be specified to 
trigger a Timer Boundary Event. 

A Timer Boundary Event displays any of the following on a diagram:

• A Timer Boundary Event name if the name is specified.

• A Time Cycle property name if the name is unspecified.

• A Time Date property if the name and Time Cycle are unspecified.

Notation
• Interrupting Timer Boundary Event

• Non-interrupting Timer Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.3 Escalation Boundary Event

Description
An Escalation Boundary Event is used to catch an escalation.

This event displays either of the following on a diagram:
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• An Escalation Boundary Event name if the name is specified.

• An Escalation Code property value if the name is unspecified.

Notation
• Interrupting Escalation Boundary Event

• Non-interrupting Escalation Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.7.4 Error Boundary Event

Description
An Error Boundary Event reacts to (catches) a named error or any error if no name is specified.

This Event always interrupts the Activity to which it is attached. The boundary of the event is always solid. 

An Error Boundary Event displays either of the following on a diagram:

• An Error Boundary Event name if the name is specified.

• An Error Ref property value if the name is unspecified.

Notation

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event
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2.2.7.5 Cancel Boundary Event

Description
A Cancel Boundary Event is used within a Transaction SubProcess.

This type of Event must be attached to the boundary of a SubProcess and will be triggered if the following 
conditions are satisfied:

• A Cancel End Event is reached within the Transaction SubProcess.

• A Transaction Protocol Cancel message is received while a transaction is being performed.

A Cancel Boundary Event always interrupts the Activity to which it is attached. The boundary of the event is 
always solid.

Notation

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.6 Compensation Boundary Event

Description
A Compensation Boundary Event is used to catch a Compensation Event. The event will be triggered by a 
compensation event. When the event is triggered, a Compensation Activity, which is associated with it, will be 
performed.

The Compensation Boundary Event in this sense does not affect the interrupting or non-interrupting aspect. 
Compensations can only be triggered after the completion of an Activity to which they are attached. Thus, they 
cannot interrupt the Activity. The boundary of the event is always solid.

Notation

Related elements
Boundary Events
Activities
Compensation

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram
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Related procedure
Creating and Using an Event

2.2.7.7 Conditional Boundary Event

Description
A Conditional Boundary Event is triggered when a specified condition becomes true. When the event is triggered, 
it will change a normal flow of a Process into an exception flow.

This event displays either of the following on a diagram:

• A Conditional Catching Intermediate Event name if the name is specified.

• A Conditional property value if the name is unspecified.

Notation
• Interrupting Conditional Boundary Event

• Non-interrupting Conditional Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.8 Signal Boundary Event

Description
A Signal Boundary Event can receive a Signal. In this context, it will change a normal flow into an exception flow 
upon being triggered.

A Signal Event differs from an Error Event because it defines a more general, non-error condition for interrupting 
Activities, such as the successful completion of another Activity, and it has a larger scope than the Error Event 
does.

Signal Boundary Event displays either of the following on a diagram:

• A Signal Boundary Event name if the name is specified.

• A Signal Ref property value if the name is unspecified.

Notation
• Interrupting Signal Boundary Event
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• Non-Interrupting Signal Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.9 Multiple Boundary Event

Description
A Multiple Boundary Event indicates that there are multiple triggers assigned to the Event. Only one of the 
specified triggers is required. The Event that occurred changes a normal flow into an exception flow.

Notation
• Interrupting Multiple Boundary Event

• Non-Interrupting Multiple Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.7.10 Parallel Multiple Boundary Event

Description
A Parallel Multiple Boundary Event indicates that there are multiple triggers assigned to the event and all of them 
are required to trigger it.
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Notation
• Interrupting Parallel Multiple Boundary Event

• Non-Interrupting Parallel Multiple Boundary Event

Related elements
Boundary Events
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.8 End Events
An End Event indicates where the path of a process ends. In terms of sequence flows, an End Event ends the flow 
of a process, and thus, does not have any outgoing sequence flow.

Types of End Events used in business process modeling are the following:

• None End Event

• Message End Event

• Error End Event

• Escalation End Event

• Cancel End Event

• Compensation End Event

• Signal End Event

• Terminate End Event

• Multiple End Event

2.2.8.1 None End Event

Description
A None Start Event does not have a defined result.

Notation

Related elements
Boundary Events
Activities
End Events
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.8.2 Message End Event

Description
A Message End Event indicates that a message will be sent when a process is completed. 

This event displays any of the following on a diagram:

• A Message End Event name if the name is specified.

• A Message Ref property value if the name is unspecified.

• An Operation Ref property if the name and Message Ref are not specified.

Notation

Related elements
End Events
Message

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.8.3 Error End Event

Description
An Error End Event indicates that a defined error will be generated, resulting in the termination of all of the 
currently active threads in a particular SubProcess.

This event displays either of the following on a diagram:

• An Error End Event name if the name is specified.

• An Error Ref property value if the name is unspecified.

Notation

Related elements
End Events
Error
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.8.4 Escalation End Event

Description
An Escalation End Event indicates that an Escalation should be triggered. Other active threads are not affected by 
this event and continue to be executed. 

This event displays either of the following on a diagram:

• An Escalation End Event name if the name is specified.

• An Escalation Code property value if the name is unspecified.

Notation

Related element
End Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.8.5 Cancel End Event

Description
A Cancel End Event is used within a Transaction SubProcess. It indicates that the transaction will be canceled and 
a Cancel Boundary Event attached to the SubProcess boundary will be triggered. It also indicates that a 
Transaction Protocol Cancel message have to be sent to all entities involved in the transaction.

Notation

Related element
End Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event
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2.2.8.6 Compensation End Event

Description
A Compensation End Event indicates that a compensation is necessary.

• If an Activity, which has successfully been completed, is identified, that Activity will be 
compensated.

• If no Activity is identified, all successfully completed Activities visible from the Compensation End 
Event will be compensated in reverse order of their sequence flows.

To be compensated, an Activity must have a Compensation Boundary Event or contain a Compensation Event 
SubProcess.

Notation

Related elements
End Events
Compensation

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.8.7 Signal End Event

Description
A Signal End Event indicates that a signal will be broadcast when the end has been reached.

This event displays either of the following on a diagram:

• A Signal End Event name if the name is specified.

• A Signal Ref property value if the name is unspecified.

Notation

Related element
End Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

A signal, which is broadcast to any process that can receive it, 
can be sent across process levels or pools.
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2.2.8.8 Terminate End Event

Description
A Terminate End Event indicates that all activities in a process have to be immediately ended, including all the 
instances of multi-instance activities. The process will be ended without any compensation or event handling.

Notation

Related element
End Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using an Event

2.2.8.9 Multiple End Event

Description
A Multiple End Event shows that there are multiple consequences of ending a process and all of them occur, for 
example, multiple messages might be sent.

Notation

Related element
End Events

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using an Event

2.2.9 Gateways
A Gateway allows you to control the flow of a process through a sequence flow. The term Gateway implies that 
there is a gating mechanism that either allows or disallows passage through the Gateway. Tokens that arrive at the 
gateway can be merged as inputs and/or split as outputs.

Types of Gateways are as follows: 

• Exclusive Gateway

• Inclusive Gateway

If the flow of a process does not need to be controlled, 
process does not need a gateway. 
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• Parallel Gateway

• Event Based Gateway

• Complex Gateway

2.2.9.1 Exclusive Gateway

Description
A diverging Exclusive Gateway (Decision) is used to create alternative paths within a process flow. This is 
basically the diversion point in the road for a process. Only one alternative path can be taken for a given instance 
of the process.

A Exclusive Gateway can be thought of as a question that is asked at a particular point in the process. The 
question has a defined set of alternative answers. Each question is associated with two or more condition 
expressions associated with outgoing sequence flows of the Gateway.

A converging Exclusive Gateway is used to merge alternative paths. All incoming sequence Flows tokens will be 
routed to the outgoing sequence flow without synchronizing them.

Notation
• Without an Internal Marker Exclusive Gateway

• An Internal Marker Exclusive Gateway

Example

Figure -- Diverging Exclusive Gateway

Related elements
Gateways
Sequence Flow

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using a Sequence Flow

There are two icons defined for an Exclusive Gateway in the BPMN2 Specification. 
It can be displayed with or without an internal marker.
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2.2.9.2 Inclusive Gateway

Description
A diverging Inclusive Gateway (Inclusive Decision) is used to create not only alternative but also parallel paths 
within a process flow. Unlike an Exclusive Gateway, it evaluates all condition expressions. The true evaluation of 
one condition expression does not exclude the evaluation of the other condition expressions. All of the sequence 
flows with true evaluation will be traversed by a token.

Since each path is considered to be independent, all combinations of the paths may be taken, from zero to all. 
However, it should be designed in such a way that at least one path is taken.

A converging Inclusive Gateway is used to merge a combination of alternative and parallel paths. A control flow 
token arriving at an Inclusive Gateway may be synchronized with some other tokens that arrive later at this 
Gateway.

Notation

Example

Figure -- Diverging Inclusive Gateway

Related elements
Gateways
Sequence Flow

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using a Sequence Flow

2.2.9.3 Parallel Gateway

Description
A Parallel Gateway is used to synchronize (combine) and create parallel flows.

Notation
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Example

Figure -- Parallel Gateway

Related elements
Gateways
Sequence Flow

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using a Sequence Flow

2.2.9.4 Event Based Gateway

Description
An Event Based Gateway represents a branching point in a process where alternative paths that follow the 
gateway are based on the events that occur rather than on the evaluation of expressions using process data (as 
with an Exclusive or Inclusive Gateway). A specific event, usually the receipt of a message, determines which path 
will be taken. Basically, an Event Based Gateway is used when a decision made by another participant is based 
on data that are not visible to the process.

Notation

Example

Figure -- Event-Based Gateway
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Related elements
Gateways
Sequence Flow
Intermediate Catch Event
Intermediate Throwing Event

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Creating and Using a Sequence Flow

2.2.9.5 Complex Gateway

Description
A Complex Gateway can be used to model complex synchronization behavior. An Activation Condition is the 
Complex Gateway’s property, which is used to describe precise behavior.

Notation

Example
The activation condition specifies that tokens on three out of five incoming sequence flows are needed to activate 
the gateway. Which token the Gateway will produce is determined by the conditions on the outgoing sequence 
flow as in the split behavior of an Inclusive Gateway.

Figure -- Complex Gateway

Related elements
Gateways
Sequence Flow

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
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BPMN Choreography Diagram

Related procedure
Creating and Using a Sequence Flow

2.2.10 Items and Data
The traditional requirement of process modeling is to be able to model the items (physical or information items) 
that are created, manipulated, and used during the execution of a process. This requirement is fulfilled in BPMN 
through various constructs: Data Objects, Item Definition, Properties, Data Inputs, Data Outputs, Messages, Input 
Sets, Output Sets, and Data Associations.

2.2.10.1 Data Object

Description
A Data Object is an element that stores or conveys items during process execution. The Data Object elements 
must be contained within the process or SubProcess elements.A Data Object element can optionally reference a 
DataState element, which is the state of data contained in a Data Object.

A Data Object element, which references an element marked as a collection, is visualized differently.

Notation
• Data Object

• Data Object that is collection

Related elements
Class
Resource
Data Association

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Data Items

2.2.10.2 Data Store

Description
A Data Store provides a mechanism for activities to retrieve or update stored information that will persist beyond 
the scope of a process.

Notation
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Related elements
Class
Resource
Data Association

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Data Items

2.2.10.3 Data Input and Data Output

Description
Activities and processes often require data in order to execute. In addition, they may produce data during or as the 
result of the execution.Data requirements are captured as Data Input. The produced data are captured using a 
Data Output notation.

Notation
• Data Input

• Data Output

Related elements
Class
Resource
Data Association

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Data Items

2.2.10.4 Data Association

Description
A Data Association is used to model how data are pushed into or pulled from item-aware elements. Tokens do not 
flow along a Data Association. Therefore, they have no direct effect on the flow of a process.

Alternatively, Data Objects can be directly associated with a Sequence Flow to represent the same input or output 
Data Associations. This is a visual shortcut that is stored in a model as two Data Associations

• from Activity to Data Object

• from Data Object to Activity
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Example

Figure -- Data Association showing flow of Data Object

Figure -- Sequence Flow representing the same Input/Output data associations

Related elements
Data Object
Data Store
Data Input and Data Output
Sequence Flow

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Data Items

2.2.11 Compensation

Description
A Compensation in business process modeling is concerned with undoing steps that have already been 
successfully completed because their results and possible side effects are no longer desired and need to be 
reversed. If an Activity is still active, it cannot be compensated and needs to be canceled. The cancellation of a 
SubProcess can produce a compensation of the already successfully completed portions of an active Activity. 

A Compensation is performed by a compensation handler. A compensation handler performs the steps necessary 
to reverse the effects of an Activity. For a SubProcess, the compensation handler will have access to the 
SubProcess data once they have been completed (“snapshot data”). 

A compensation handler is a set of Activities that is not connected to other portions of the BPMN model. The 
compensation handler starts with either of the Compensation Events: 

• Compensation Boundary Event

• The handler’s Start Event (in case of a Compensation Event SubProcess) 

A compensation handler connected through a boundary event can only perform a “black-box” compensation of the 
original Activity. This compensation is modeled with a specialized Compensation Activity, which is connected to 
the boundary event through an association. The Compensation Activity, which can be either a Task or a 
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SubProcess, is marked to show that it is used for compensation only and is located outside the normal flow of the 
Process.

Figure -- Compensation handler connected through Compensation Boundary Event

Another way to model a compensation is using a compensation handler, which starts with a Start Event of an 
Event SubProcess that is contained within a Process or SubProcess. Just like any other Compensation Activities, 
a Compensation Event SubProcess is located outside the normal flow of a process. The Event SubProcess, which 
is marked with a dotted line boundary, has access to data that are part of the parent, which is a snapshot at the 
point in time when the parent has been completed. A Compensation Event SubProcess can recursively trigger a 
compensation for activities contained in its parent.

Example

Figure -- Compensation defined by Event SubProcess

Related elements
BPMN Process
SubProcesses
Compensation Start Event
Escalation Throwing Intermediate Event
Compensation Boundary Event
Association

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
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Related procedure
Using Activities

2.3 BPMN Collaboration Diagram
Description
A Collaboration represents the interactions between two or more business entities. A Collaboration diagram 
depicts a global point of view. It shows the interactions between participants in general.

A Collaboration contains two or more pools, representing the participants in the collaboration. Messages 
exchanged between the participants are shown by message flows that connect two pools together (or objects 
within the pools).

Figure -- Collaboration diagram with two Black Box Pools

Figure -- Collaboration diagram with two Pools showing process
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A Collaboration diagram can also show distinct conversations between collaborating participants in a domain. 
Communications are defined by the conversations, participants, and conversation links between them.

Figure -- BPMN Collaboration diagram with Conversations

The elements of a BPMN Process diagram can be displayed on the BPMN Collaboration diagram.

Related element
BPMN Process

Related diagram
BPMN Process Diagram

2.3.1 Collaboration

Description
A Collaboration element provides a description of collaborations between pools. This element is a container for a 
BPMN Collaboration diagram and its elements.

Related elements
Pool and Lane
Participant

Related diagram
BPMN Collaboration Diagram

2.3.2 Pool and Lane

Description
A Pool represents a participant in a collaboration. The participant can be a specific partner entity, for example, a 
company, or it can be a more general partner role, such as a buyer, seller, or manufacturer. Graphically, a Pool is 
a container to partition a process from the other pools.

A Pool can contain a process, or it can be a black box.

A Pool with suppressed content will display a multi-instance marker if the participant referenced by the pool has a 
minimum multiplicity value of two or more.
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A Lane is a sub-partition within a pool. Lanes are used to organize and categorize activities within a pool 
according to function or role. They are as follows:

• internal roles, for example, Manager and Associate

• systems, for example, an enterprise application

• internal departments, for example, shipping or finance 

In addition, Lanes can be nested in a pool. For example, there could be an outer set of Lanes for company 
departments and an inner set of Lanes for the roles within each department

Notation
• Pool that contains a process or black box

• Pool with suppressed content

• A Pool with Suppressed Contents Referencing a Multi-instance Participant
Copyright © 2009-2015 No Magic, Inc.                                                                                                                                                  63



BPMN Collaboration Diagram
Example

Figure -- Pool with nested Lanes

Related elements
Resource
Organization Unit
Role
Person
Message Flow

Related diagrams
BPMN Collaboration Diagram
BPMN Process Diagram

Related procedure
Creating and Using Pool and Lanes

2.3.3 Message Flow

Description
A Message Flow is used to show the flow of messages between two participants who are prepared to send and 
receive them.

Messages that are sent by a Message Flow can be displayed on a diagram in two ways: 

• overlapping the Message Flow

• associated with the Message Flow

• A Message Flow must connect separate Pools. It can be connected 
to the pool boundary or an element inside the pool.

• A Message Flow cannot connect two elements in the same Pool.
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However, they can also be hidden.

Example

Figure -- Message Flows between two pools.

Figure -- Messages overlapping Message Flows
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Figure -- Messages associated with Message Flows

Figure -- Message Flows between Pools Inner elements

Related element
Pool and Lane

Related diagrams
BPMN Collaboration Diagram
BPMN Process Diagram

Related procedure
Creating and Using a Sequence Flow
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2.3.4 Message

Description
A Message represents the content of communications between two participants. It is passed by a message flow 
and is sent or received by a message event.

Notation

Related elements
Message Flow
Choreography Task

Related diagrams
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Creating and Using Message Flow
Creating and Using Choreography Task

2.3.5 Conversation

Description
A Conversation is an atomic element for a BPMN Collaboration diagram. It represents a set of message flows that 
is grouped together.

A Conversation can involve two or more Participants. A Conversation Link path will be from a Conversation to the 
involved Participants (Pools).

Notation

Related elements
Pool and Lane
Conversation Link

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Creating and Using Conversation Nodes

2.3.6 SubConversation

Description
A SubConversation is a conversation node considered as a hierarchical division within a parent’s conversation.
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A SubConversation is represented as a graphical object within a BPMN Conversation diagram, but it can also be 
opened up to show a lower-level conversation, which consists of message flows, communications, and/or other 
SubConversations. A SubConversation shares the participants of its parent conversation.

Notation

Related elements
Pool and Lane
Conversation Link
Conversation

Related diagrams
BPMN Collaboration Diagram
BPMN Process Diagram

Related procedure
Creating and Using Conversation Nodes

2.3.7 Call Conversation

Description
A Call Conversation identifies a place in a conversation where a Conversation is used.

Notation
• Call Conversation that does not call any conversation.

• Call Conversation calling Global Conversation

Related elements
Collaboration
Pool and Lane
Conversation Link

Related diagrams
BPMN Collaboration Diagram
BPMN Process Diagram

Related procedure
Creating and Using Conversation Nodes
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2.3.8 Conversation Link

Description
A Conversation Link is used to connect conversation nodes (Communication, SubConversation, and Call 
Conversation) to and from Participants (Pools).

Example

Figure -- Conversation Link notation

Related elements
Collaboration
SubConversation
Call Conversation
Conversation

Related diagram
BPMN Collaboration Diagram

2.3.9 Participant

Description
A Participant represents a specific partner entity, such as a company and a more general partner role, for 
example, a buyer, seller, or manufacturer who is a participant in a collaboration. A Participant is often responsible 
for the execution of a process enclosed in a pool.

Participant element can be contained only in Collaboration or Choreography and represent Resource.

Related elements
Pool and Lane
Conversation
Choreography Activities

Related diagrams
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Using BPMN Collaboration Diagram
Creating and Using Pool and Lanes
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2.4 BPMN Choreography Diagram
Description
A Choreography formalizes the way business participants coordinate their interactions. A Choreography is a type 
of process, but its purpose and behavior are different from a standard BPMN process.

A standard process defines the flow of activities of a specific partner entity or organization. In contrast, a 
Choreography formalizes the way business participants coordinate their interactions. The focus is not on the work 
performed within these participants, but rather on the information (messages) exchanged between them.

A Choreography is a definition of expected behavior, basically a procedural business contract between interacting 
participants. It shows the messages exchanged and their logical relations. This allows business partners to plan 
their business processes for inter-operation without introducing conflicts.

Figure -- BPMN Choreography diagram

A BPMN Choreography diagram is based on the UML Activity diagram and includes restrictions and extensions as 
defined by BPMN. 

Types of Choreography elements are as follows:

• Choreography

• Choreography Activities

Related elements
Choreography
Choreography Activities
Error
Intermediate Catch Event
Intermediate Throwing Event
Boundary Events
End Events
Gateways

Related diagram
BPMN Process Diagram

Related procedure
Using BPMN Choreography Diagram

2.4.1 Choreography

Description
A Choreography is a container for a BPMN Choreography diagram and its elements.

Related diagram
BPMN Choreography Diagram
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2.4.2 Choreography Activities
A Choreography Activity is an abstract element. It represents a point on a choreography flow where an interaction 
occurs between two or more participants.

There are three types of Choreography activities defined in business process modeling:

• Choreography Task

• SubChoreography

• Call Choreography

The shape of a Choreography Task, SubChoreography, or Call Choreography consists of two or more participant 
compartments and one name compartment. One of the participants can be selected as an initiating participant. 
The color of the initiating participant compartment is the same as the color of the name compartment. The other 
participants compartments are gray.

Figure -- Compartments on Choreography Activity shape

The looping properties of a Choreography Activity can be specified. They can be repeated sequentially, essentially 
behaving like a loop. The presence of loop characteristics signifies that the Choreography Activity has looping 
behavior. There are two types of Looping characteristics defined in BPMN: 

• Standard Loop 
A Standard Loop marker displayed on a name compartment of a Choreography Activity shape 
shows that the looping behavior based on a boolean condition is defined for this Activity. 
Additional looping characteristics can also be defined: the Activity will loop as long as the boolean 
condition is true. The condition is evaluated for every loop iteration and can be evaluated at the 
beginning or end of the iteration. In addition, a numeric cap can be optionally specified, but the 
number of iterations cannot exceed this cap.

• Choreography Activity with Standard Loop marker

• SubChoreography with Standard Loop marker

• Multi-instance Loop
A Multi-instance Loop marker shows that a desired number of Choreography Activity instances 
can be created. The instances can be executed either in parallel or sequentially and each will be 
identified using a different marker.
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• Choreography Task with Parallel MultiInstance Loop marker

• SubChoreography with Parallel MultiInstance Loop marker

• Choreography Task with sequential MultiInstance Loop marker

• SubChoreography with sequential MultiInstance Loop marker

There are circumstances when a Choreography Activity references a multi-instance participant (the minimum 
multiplicity property value for a participant is 2 or greater). A multi-instance participant represents a situation where 
there is more than one possible related participant involved in a Choreography. If this is the case, a MultiInstance 
marker will be displayed in the participant compartment of a Choreography Activity shape.

Related diagram
BPMN Process Diagram

Related procedure
Using Choreography Activity

2.4.2.1 Choreography Task

Description
A Choreography Task is an atomic Activity in a choreography process. It represents one or more messages 
exchanged between two Participants.A Choreography Task can display messages that are defined by the 
referenced Message Flows. The messages connected to an Initiating Participant compartment are white and 
those connected to a Non-Initiating Participant compartment are gray.

Multi-instance Loop and Standard Loop markers can be added to all 
types of Choreography activities.
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Notation

Example

Figure -- Choreography task corresponding to BPMN Collaboration diagram

Figure -- Choreography task with Messages Corresponding to BPMN Collaboration diagram

Related elements
Organization Unit
Role
Person
Choreography Activities

Related diagrams
BPMN Collaboration Diagram
BPMN Choreography Diagram
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Related procedures
Creating and Using Choreography Task
Using Choreography Activity

2.4.2.2 SubChoreography

Description
A SubChoreography is a compound Activity that can include choreography activities and define their flows. It can 
be expanded to show its details within the choreography in which it is contained.

It can also be displayed in a collapsed view to hide its details. A collapsed SubChoreography is indicated with a 
plus sign (+) to distinguish itself from a Choreography Task.

Notation

Example

Figure -- Expanded SubChoreography

Figure -- Collapsed SubChoreography

Related elements
Organization Unit
Role
Person
Choreography Activities

Related diagram
BPMN Choreography Diagram
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Related procedures
Creating SubChoreography
Using Choreography Activity

2.4.2.3 Call Choreography

Description
A Call Choreography identifies the point in a process where a global choreography is used. It acts as a place 
holder to include a choreography element it is calling.

A Call Choreography is with a thick border.

Notation
• Call Choreography

• A Call Choreography referencing another Choreography is marked with a plus (+) sign.

Related elements
Organization Unit
Role
Person
Choreography Activities
Choreography

Related diagram
BPMN Choreography Diagram

Related procedures
Creating Call Choreography Activity
Using Choreography Activity
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2.5 Numbering Elements
Cameo Business Modeler offers an automatic numbering feature to number specific types of BPMN elements. 
Each element number is saved in an ID property of element specification.

Figure -- BPMN Process Diagram showing element numbers

Numbering elements are described in the following sections:

• Numbering Schemas

• Element Types Numbering Sequence

2.5.1 Numbering Schemas
Types of numbering schemas predefined for BPMN elements are as follows:

• Multilevel with Owner Number

• Multilevel without Owner Number

• Consecutive with Owner Number

• Consecutive without Owner Number

2.5.1.1 Multilevel with Owner Number

Description
A Multilevel with Owner Number numbering schema provides multilevel element numbering. An Element owner 
(BPMN Process, BPMN Collaboration, or Choreography) number is displayed before the element number.

Example

Figure -- Multilevel Numbering style with element owner number

A Multilevel with Owner Number numbering schema is the default schema 
for all BPMN diagram elements.
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers

2.5.1.2 Multilevel without Owner Number

Description
A Multilevel without Owner Number numbering schema provides multilevel element numbering. An Element owner 
(BPMN Process, BPMN Collaboration, or Choreography) number is not included in the element number.

Example

Figure -- Multilevel Numbering style without element owner number

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers

2.5.1.3 Consecutive with Owner Number

Description
A Consecutive with Owner Number numbering schema provides non-multilevel element numbering. An Element 
owner (BPMN Process, BPMN Collaboration, or Choreography) number is displayed before the element number.

When a Multilevel without element number numbering schema is used, the numbers 
in a project are not unique. Elements with the same number can exist in multiple 
diagrams.
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Example

Figure -- Consecutive Numbering style with element owner number

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers

2.5.1.4 Consecutive without Owner Number

Description
A Consecutive without Owner Number numbering schema provides non-multilevel element numbering. An 
Element Owner (BPMN Process, BPMN Collaboration, or Choreography) number is not included in the element 
number.

Example

Figure -- Consecutive numbering style without owner number

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers
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2.5.2 Element Types Numbering Sequence
Cameo Business Modeler uses a predefined sequence of numbers for specific element types as described in 
table.

Element Type Description
BPMN Process A BPMN Process is numbered in the scope of a project. A BPMN Process number has 

“P” as a prefix. 

BPMN Collaboration A BPMN Collaboration is numbered in the scope of a project. A BPMN Collaboration 
number has “C” as a prefix.

Choreography A Choreography is numbered in the scope of a project. A Choreography number has 
“CH” as a prefix.

Flow Node A Flow Node element is numbered in the scope of an owner element (BPMN Process, 
BPMN Collaboration, or Choreography). The elements that belong to the Flow Node 
element type category are as follows:
• All types of tasks
• All types of Subprocesses
• Call activities
• Choreography tasks
• Sub-choreographies
• Call choreographies
• All types of gateways
• All types of events

Item Aware Element An Item Aware Element is numbered in the scope of an owner element. An Item 
Aware Element number has “D” as a prefix.
The elements that belong to the Item Aware element type category are as follows:

• Data Object
• Data Store
• Data Input
• Data Output
• Property

Conversation Node A Conversation Node element is numbered in the scope of an owner element. A 
Conversation Node number has “Conv” as a prefix.
The elements that belong to the Conversation Node element type category are as 
follows:

• Conversation
• Sub-conversation
• Call Conversation

Resource Role A Resource Role element is numbered in the scope of an owner element. A Resource 
Role number has “RR” as a prefix.
The elements that belong to the Resource Role element type category are as follows:

• Human Performer
• Performer
• Potential Owner
• Resource Role
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Figure -- Numbered BPMN Process, BPMN Collaboration, and Choreography in Containment tree

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers

2.6 XPDL Support
XML Process Definition Language (XPDL) is a serialization format for BPMN. XPDL provides a file format that 
supports all BPMN process definition description properties. It defines a description of both model element 
properties and graphical descriptions of the diagram. With XPDL, Cameo Business Modeler can export or import 
process definitions for or from other products to read. It also allows you to exchange your models with other tools 
to perform further model simulation, execution, or deployment.

Cameo Business Modeler plugin supports export of BPMN models to XPDL Version 2.2. This version is backward 
compatible with previous versions of XPDL and can be used to export BPMN2 and BPMN 1.x models.

Cameo Business Modeler supports importing from XPDL Versions 2.0, 2.1, and 2.2 to BPMN2. Business process 
models created with other tools (e.g. Visio, BizAgi, Process Architect, etc) can be imported to Cameo Business 
Modeler.

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedure
Exporting Models to XPDL

2.7 BPMN2 XML support
Cameo Business Modeler supports exporting BPMN2 models as BPMN2 Diagram Interchange files. The BPMN2 
Diagram Interchange is a format for interchanging BPMN2 diagrams between tools. Its reduced ambiguity allows 
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the users to exchange BPMN models between tools more conveniently. You can export a BPMN2 diagram as a 
BPMN2 Diagram Interchange file (BPMN2 XMI).

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Exporting Models to BPMN2
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3 SUPPORTIVE DIAGRAMS 
CONCEPTS
This chapter describes how to create and modify supportive diagrams, BPMN Matrices, Tables, and Process 
Structure Map.

The chapter contains the following sections:

• Business Motivation Diagram

• Business Data Diagram

• Organization Structure Diagram

• Process Definition Diagram

• BPMN Tables

• BPMN Matrices

• BPMN Processes Structure Map

3.1 Business Motivation Diagram
Description
The Business Motivation Model designed to develop, communicate, and manage business plans. The model 
identifies and defines the elements of business plans, the motivating factors to establish the business plans, and 
how all these factors and elements are interconnected.

Example

Figure -- Business Motivation Diagram

Related elements
Ends Concepts
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Means Concepts
Influencer Concepts
Assessment Concepts

3.1.1 Ends Concepts
The Ends elements show what an organization wants to achieve.

There are three types of End elements:

• Vision

• Goal

• Objective

• End Concept Relationships

3.1.1.1 Vision

Description
A vision is a state where an organization wants to achieve in the future. It is common that a vision is made up of 
many aspects rather than concentrated on a specific factor of the business problem. It is the final, possibly 
unattainable, state the organization would like to accomplish. It does not describe how the organization will 
achieve the state. A Vision is often compound, rather than focused toward one particular aspect of the business 
problem. It is supported or made operative by Missions and amplified by Goals.

Notation

Related elements
Ends Concepts
End Concept Relationships

Related diagram
Business Motivation Diagram

3.1.1.2 Goal

Description
Unlike vision, a goal should generally be attainable and should be more specifically oriented to a single aspect of 
the business problem. A Goal is a statement about a state or condition of the enterprise to be brought about or 
sustained through appropriate Means. A Goal amplifies a Vision.It indicates what must be satisfied on a continuing 
basis to effectively attain the Vision.

Notation
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Related elements
Ends Concepts
End Concept Relationships

Related diagram
Business Motivation Diagram

3.1.1.3 Objective

Description
An Objective is a statement of an attainable, time-targeted, and measurable target that the enterprise seeks to 
meet in order to achieve its Goals.

Notation

Related elements
Ends Concepts
End Concept Relationships

Related diagram
Business Motivation Diagram

3.1.1.4 End Concept Relationships
The relationships that are allowed between elements are as follows.

Relationships Description Example
Amplifies This link connects Goal to a Vision. Meaning that the Goal 

gives an emphasis on what must be done over a prolonged 
period to achieve the desired Vision.

Quantifies This link connects Objective to a Goal. Meaning that the 
Objective provides a specific time frame (for example, in June 
2013) to work towards the Goal and it also gives a basis for 
evaluating whether the Goal is being accomplished.
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Related element
Ends Concepts

Related diagram
Business Motivation Diagram

3.1.2 Means Concepts
The Means elements provide a method to achieve the ends. 

There are five types of Means elements:

• Mission

• Strategy

• Tactic

• Business Policy

• Business Rule

• Mean Concept Relationships

3.1.2.1 Mission

Description
A Mission indicates the ongoing operational Activity of the enterprise. The Mission describes what the business is 
or will be doing on a day-to-day basis.

A Mission makes a Vision operative. It indicates the ongoing Activity that makes the Vision a reality. A Mission is 
planned by means of Strategies.

Notation

Related elements
Means Concepts
Mean Concept Relationships

Related diagram
Business Motivation Diagram

3.1.2.2 Strategy

Description
A Strategy is one component of the plan for the Mission. A Strategy represents the essential Course of Action to 
achieve Ends (Goals in particular). A Strategy usually channels efforts towards those Goals.

A Strategy is more than simply a resource, skill, or competency that the enterprise can call upon. It is accepted by 
the enterprise as the right approach to achieve its Goals, given the environmental constraints and risks.
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Notation

Related elements
Means Concepts
Mean Concept Relationships

Related diagrams
Business Motivation Diagram
Process Definition Diagram

3.1.2.3 Tactic

Description
A Tactic is a Course of Action that represents part of the detailing of Strategies. A Tactic implements Strategies. 
For example, the Tactic “Call first-time customers personally” implements the Strategy “Increase repeat business.”

Tactics generally channel efforts towards Objectives. For example, the Tactic “Ship products for free” channels 
efforts towards the Objective “Within six months, 10% increase in product sales”.

Notation

Related elements
Means Concepts
Mean Concept Relationships

Related diagrams
Business Motivation Diagram
Process Definition Diagram

3.1.2.4 Business Policy

Description
A Business Policy is a Directive that is not directly enforceable whose purpose is to govern or guide the enterprise. 
Business Policies provide the basis for Business Rules. Business Policies also govern Business Processes.

Notation

Related elements
Means Concepts
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Mean Concept Relationships

Related diagrams
Business Motivation Diagram
Process Definition Diagram

3.1.2.5 Business Rule

Description
A Business Rule is a Directive, intended to govern, guide, or influence business behavior, in support of Business 
Policy that has been formulated in response to an Opportunity, Threat, Strength, or Weakness. It is a single 
Directive that does not require additional interpretation to undertake Strategies or Tactics. Often, a Business Rule 
is derived from Business Policy. Business Rules guide Business Processes.

Notation

Related elements
Means Concepts
Mean Concept Relationships

Related diagrams
Business Motivation Diagram
Process Definition Diagram

3.1.2.6 Mean Concept Relationships
The following table provides the relationships that exist between element types and their meaning.

Relationship Description Example
Makes Operative This link connects Mission to a Vision. 

Meaning that the Mission lists every continuing 
Activity to ensure the Vision. 

Component Of This link connects Strategy to a Mission. 
Meaning that the Strategy is the method or 
course of action that will be employed to 
achieve the Mission.
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Implements This link connects Tactic to a Strategy. 
Meaning that the Tactic realizes Strategies.

Enables This link connects Strategy to a Strategy or 
Tactic to a Tactic. Meaning that a Strategy/
Tactic makes another Strategy/Tactic doable. 
That is to say the latter Strategy/Tactic 
provides an opportunity for the former 
Strategy/Tactic to be carried out. Use this link 
to associate Strategy to another Strategy or 
Tactic to another Tactic.

Effects Enforcement Level This link connects Tactic to a Business Rule. 
Meaning that the Tactics influences the 
enforcement level of Business Rule.

Formulated Based On This link connects Strategy or Tactic to a 
Business Policy or Business Rule. Meaning 
that the Strategy or Tactic is planned according 
to what result the Business Policy or Business 
Rule desires.

Channel Efforts Towards This link connects Strategyto a Goal, or Tactic 
to an Objective. Meaning that the Strategy is 
coordinated as activities aimed towards Goals 
as Tactic towards Objective. For example, the 
Tactic “Free delivery” channels efforts towards 
the Objective “5% increase in sales within 3 
months.”

Relationship Description Example
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Related element
Means Concepts

Related diagrams
Business Motivation Diagram
Process Definition Diagram

Governs This link connects Business Policy or 
Business Rule to a Strategy or Tactic. 
Meaning that the Business Policy or Business 
Rule determines the Strategy or Tactic.

Basis For This link connects Business Policy to a 
Business Rule. Meaning that the Business 
Policy is the key to achieve Business Rule.

Supports Achievement Of This link connects Business Policy or 
Business Rule to a Goal or Objective. 
Meaning that the Business Policy provides an 
idea or reason to develop the Strategy or 
Tactic.

Acts As Regulation This link connects a Business Policy or a 
Business Rule to External Influencer.

Relationship Description Example
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3.1.3 Influencer Concepts
The Influencer elements come up with the factors that are influencing the ends achievement of the organization.

Types of Influencer elements are as following:

• External Influencer

• Internal Influencer

• Influencing Organization

• Influence Concepts Relationship

3.1.3.1 External Influencer

Description
External Influencer is this outside an enterprise's organizational boundary that can impact its employment of 
Means or achievement of Ends. External Influencer is usually categorized as follows:

• Competitor: A rival enterprise in a struggle for advantage over the subject enterprise.

• Customer: A role played by an individual or enterprise that has investigated, ordered, received, or 
paid for products or services from the subject enterprise.

• Environment: The aggregate of surrounding conditions or Influencers affecting the existence or 
development of an enterprise.

• Partner: An enterprise that shares risks and profit with the subject enterprise (or is associated with 
the subject enterprise to share risks and profit) because this is mutually beneficial.

• Regulation: An order prescribed by an authority such as a government body or the management 
of an enterprise.

• Supplier: A role played by an individual or enterprise that can furnish or provide products or 
services to the subject enterprise.

• Technology: The role of technology, including its developments and limitations — there may be 
prerequisites for use of technology; there may be enterprise Activity that technology enables or 
restricts.

Notation

Related elements
Influencer Concepts
Influence Concepts Relationship

Related diagram
Business Motivation Diagram

3.1.3.2 Internal Influencer

Description
Internal Influencer is an enterprise that can impact its employment of Means or achievement of Ends.

Internal Influencer is usually categorized the following:

• Assumption: Something that is taken for granted or without proof.
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• Explicit Corporate Value: An ideal, custom, or institution that an enterprise promotes or agrees 
with that is explicitly set forth and declared.

• Implicit Corporate Value: A corporate value that is not explicitly declared but nonetheless 
understood by some or all of the people in an enterprise.

• Habit: A customary practice or use.

• Infrastructure: The basic underlying framework or features of a system.

• Issue: A point in question or a matter that is in dispute as between contending partners.

• Management Prerogative: A right or privilege exercised by virtue of ownership or position in an 
enterprise.

• Resource: The resources available for carrying out the business of an enterprise, especially their 
quality.

Notation

Related elements
Influencer Concepts
Influence Concepts Relationship

Related diagram
Business Motivation Diagram

3.1.3.3 Influencing Organization

Description
An Influencing Organization is an organization that is external to the enterprise modeled in a given enterprise 
BMM, and that influences that enterprise.

An Influencing Organization is the source of Influencer. The Influencer may have multiple sources, or none.

Notation

Related elements
Influencer Concepts
Influence Concepts Relationship

Related diagram
Business Motivation Diagram
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3.1.3.4 Influence Concepts Relationship
The following table provides the relationship that exists between element types and the meaning.

Related elements
Influencer Concepts

Related diagram
Business Motivation Diagram

3.1.4 Assessment Concepts
The Assessment element is the Influencer's assessment of the organization ends and means including the 
activities, events, and data that trigger or feed business activities.

There are three types of Assessment elements:

• Assessment

• Risk

• Potential Reward

• Assessment Concept Relationships

3.1.4.1 Assessment

Description
An Assessment is a judgment of some Influencer that affects the ability of organization to employ its Means or 
achieve its Ends. In other words, an Assessment expresses a logical connection or fact type between Influencers 
and the Ends and/or Means of the business plans. In this way, an Assessment indicates which Influencers are 
relevant to which Ends and/or Means.

Notation

Related elements
Assessment Concepts
Assessment Concept Relationships

Related diagram
Business Motivation Diagram

Relationship Description Example
Is Source Of This link connects Influencing Organization to an 

Influencer (External Influencer or Internal Influencer). 
Meaning that the Influencing Organization is the source of 
Influencer. An Influencer may have multiple sources, or 
none.
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3.1.4.2 Risk

Description
A Risk is a category of Impact Value that indicates the impact and probability of loss. Some Risks are expressible 
as formulas, for example:

• Probability of loss (for example, 5% probability)

• Potential loss (for example, $500,000 loss)

• Unit-of-measure (for example, loss in USD)

Notation

Related elements
Assessment Concepts
Assessment Concept Relationships

Related diagram
Business Motivation Diagram

3.1.4.3 Potential Reward

Description
A Potential Reward is a category of Potential Impact that indicates the probability of gain. Some Potential Rewards 
are expressible as formulas, for example:

• Probability of gain (for example, 30% probability)

• Potential gain (for example, $40,000 gain)

Notation

Related elements
Assessment Concepts
Assessment Concept Relationships

Related diagram
Business Motivation Diagram

3.1.4.4 Assessment Concept Relationships

Description
The following table provides the relationships that exist between element types and their meaning.
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Relationship Description Example
Identifies This link connects Assessment to a Potential Reward or 

Risk. Meaning that the Assessment points out some 
possible Potential Reward or Risk that is/are significant to 
that Assessment. Each possible consequence serves as 
an appraisal of the worth, value, or quality of some aspect 
of the Assessment in specific terms, types, or dimensions.

Provides 
Impetus

This link connects Assessment to a Business Policy or 
Business Rule. Meaning that the Assessment is the 
driving force for the Business Policy or Business Rule.

Affects 
Achievements

This link connects Assessment to a Vision, Goal, or 
Objective. Meaning that the Assessment has an impact on 
the End outcomes.

Affects 
Employment

This link connects Assessment to a Mission, Strategy, 
Tactic, Business Policy or Business Rule. Meaning that 
the Assessment has an impact on the use of Means.

Judgement 
For

This link connects Assessment to a Influencer (External 
Influencer or Internal Influencer). Meaning that the 
Assessment is the Influencer’s judgment that influences 
the organization’s ability to carry out its Means or achieve 
its Ends.
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Related element
Assessment Concepts

Related diagram
Business Motivation Diagram

3.2 Business Data Diagram
Description
A Business Data diagram provides possibilities to define what business concepts are used in business processes. 
The diagram shows classes that represent concepts we can identify in a business area. Therefore, it allows 
defining properties and relations between classes. Class elements identified in Business Data diagrams are 
represented by Data Object elements and can be reused later in the BPMN Process diagram.

Business Data Diagram is based on UML Class diagram. It is a simplified version of the class diagram that 
includes only model elements needed for business data definitions.

Example

Figure -- Business Data Diagram showing Classes

Related elements
Class
Association
Generalization

3.2.1 Class

Description
A Class element represents data or a concept that is related to problem area and is used by business processes. 
To define more information about a class, you can add class properties for the class.
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Notation
• Class

• Class with properties

Related elements
Association
Generalization
Data Object

Related diagrams
Business Data Diagram
BPMN Business Data Description Table
BPMN Data Usage Matrices

3.2.2 Association

Description
An Association link shows that particular classes are related to each other. Association links may have names 
defined – names help to read diagrams. You can also specify multiplicity at the end of an Association.

Example

Figure -- Association between two Classes with Multiplicity at the End

Related element
Class

Related diagram
Business Data Diagram

3.2.3 Generalization

Description
A Generalization link shows that one class provides grouping criteria for sets of other classes. Generic class may 
define sets of properties, that are applicable to all the specific classes. The Generalization link can be among 
classes.
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Example

Figure -- Generalization link defining Properties to all specific Classes

Related element
Class

Related diagram
Business Data Diagram

3.3 Organization Structure Diagram
Description
An Organization Structure Diagram represents the hierarchical structure of an organization. This diagram allows 
showing organization departments, roles inside departments, and actual persons inside an organization. The 
diagram can also represent the reporting structure of an organization.

Example

Figure -- Organization Structure diagram

Related elements
Resource
Organization Unit
Role
Person
Information system
Composition
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3.3.1 Resource

Description
The Resource is used to specify resources that can be referenced by Process. These Resources can be human 
resources as well as any other resource assigned to Activities during Process execution time.

Multiple processes can utilize the same Resource.

Resource can be element of the Organization structure such as Organization Unit, Role or Person.

Related elements
Organization Unit
Role
Person
Information system
Pool and Lane
Activities
Choreography Activities

Related diagrams
Organization Structure Diagram
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram
BPMN Resources Usage Matrices

Related Procedure
Using Organization Structure Diagram

3.3.2 Organization Unit

Description
An organization represents a group of persons, associated for a particular purpose. An Element may denote an 
organization, a department, or a working group inside an organization. e. g., the company, sale department, etc. 
This element is combined with the Participant definition.

Notation

Related elements
Resource
Role
Person
Information system
Pool and Lane
Activities
Choreography Activities
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Related diagrams
Organization Structure Diagram
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram
BPMN Resources Usage Matrices

Related Procedure
Using Organization Structure Diagram

3.3.3 Role

Description
A Role is a type of contact point or a responsible person, e. g., cashier, ticket seller counter, etc. Roles may belong 
to an organization. This element is combined with the Resource Role definition.

Notation

Related elements
Resource
Organization Unit
Person
Information system
Pool and Lane
Activities
Choreography Activities

Related diagrams
Organization Structure Diagram
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram
BPMN Resources Usage Matrices

Related Procedure
Using Organization Structure Diagram

3.3.4 Person

Description
A Person is a type of human that is recognized by law as the subject of rights and duties. This element is 
combined with the Resource Role definition.
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Notation

Related elements
Resource
Organization Unit
Role
Information system
Pool and Lane
Activities
Choreography Activities

Related diagrams
Organization Structure Diagram
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram
BPMN Resources Usage Matrices

Related Procedure
Using Organization Structure Diagram

3.3.5 Information system

Description
An Information System is a type of hardware or a software, e. g., international sales system, ticket reservation 
system, etc. Information system can be used by Process or Process Activity.

Notation

Related elements
Resource
Organization Unit
Role
Person
Pool and Lane
Activities
Choreography Activities

Related diagrams
Organization Structure Diagram
BPMN Process Diagram
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BPMN Collaboration Diagram
BPMN Choreography Diagram
BPMN Resources Usage Matrices

Related Procedure
Using Organization Structure Diagram

3.3.6 Composition

Description
A Composition is a key relationship that shows how organization structure is composed. For example, one 
organization unit can be a part of a parent organization.

Example

Related elements
Resource
Organization Unit
Role
Person
Information system

Related diagrams
Organization Structure Diagram

Related Procedure
Using Organization Structure Diagram

3.4 Process Definition Diagram
Description
A Process Definition diagram is a tool for initial process analysis. The diagram allows you to draw business 
processes, group them into packages, and define the relations between those processes.

When the initial process definition has been completed, a process flow can be provided in a BPMN Process 
diagram, which can be created for each process.
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Example

Figure -- Process Definition diagram

Related elements
BPMN Process
Package
Assessment Concept Relationships

3.4.1 Package

Description
Package groups together processes and other model elements. You can organize all types of model elements into 
packages. The Packages themselves can be nested within other Packages.

Notation

Related diagram
Process Definition Diagram

3.4.2 Relationships
Process Definition diagram has relationships as follows:

• Usage
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• Dependency

• Realizes

• Governs

• Guides

3.4.2.1 Usage

Description
A Usage is a relationship in which one element requires another element (or set of elements) for its full 
implementation or operation.

Example

Related element
BPMN Process

Related diagram
Process Definition Diagram

3.4.2.2 Dependency

Description
A Dependency indicates a semantic relationship between two model elements (or two sets of model elements). 
Dependency indicates a situation in which a change to a supplier (target) element may require a change to a client 
(source) element in the dependency.

A Dependency is shown as a dashed arrow between model elements. The model element at the start point of the 
arrow (the client element) depends on the model element at the arrowhead (the supplier element). The arrow can 
be labeled with an optional individual name.

Example

Related element
BPMN Process

Related diagram
Process Definition Diagram
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3.4.2.3 Realizes

Description
Realizes shows that a BPMN Process can realizes a Strategy or Tactic.

Example

Related element
BPMN Process

Related diagram
Process Definition Diagram

3.4.2.4 Governs

Description
Governs shows that a Business Policy governs BPMN Process.

Example

Related element
BPMN Process

Related diagram
Process Definition Diagram

3.4.2.5 Guides

Description
Guides shows that a Business Rule guides a BPMN Process.

Example

Related elements
BPMN Process
Strategy
Tactic
Business Policy
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Business Rule

Related diagram
Process Definition Diagram

3.5 BPMN Tables
BPMN tables allow the quick creation of BPMN elements as well as easy review and modification of their 
properties. You can review a group of elements as one set in the same place by using these tables.

Types of BPMN tables in Cameo Business Modeler are as follows:

• BPMN Processes Description Table

• BPMN Resources Description Table

• BPMN Business Data Description Table

BPMN Activities Description TableRelated external resource
“Generic Table” in MagicDraw UserManual.pdf

3.5.1 BPMN Processes Description Table

Description
A BPMN Processes Description table is designed to display or edit processes descriptions in a table form. You can 
display existing processes or create new processes in this table.

Example

Figure -- BPMN Processes Description table

Related elements
BPMN Process
BPMN Tables

Related procedure
Creating BPMN Processes Description Table
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3.5.2 BPMN Resources Description Table

Description
A BPMN Resources Description table is designed to display or edit resources description in a table form. You can 
display existing Resources or create new ones in this table.

BPMN defines four types of Resources as follows:

• Resource

• Organization Unit

• Role

• Person

• Information System

You can display all of them in a BPMN Resources Description table.

Example

Figure -- BPMN Resource Roles Description table

Related elements
Resource
BPMN Tables

Related procedure
Creating BPMN Resources Description Table

3.5.3 BPMN Business Data Description Table

Description
A BPMN Business Data Description table is designed to display or edit class descriptions in a table form. You can 
display existing classes or create new classes in this table.
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Figure -- BPMN Business Data Description table

Related elements
Class
BPMN Tables

Related procedure
Creating BPMN Business Data Description Table

3.5.4 BPMN Activities Description Table

Description
A BPMN Activities Description table is designed to display or edit selected process activities descriptions in a table 
form. A BPMN Activities Description table is created for a BPMN Process.

Figure -- BPMN Activities Description table

Related elements
Activities
BPMN Tables

Related procedure
Creating BPMN Activities Description Table
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3.6 BPMN Matrices
A BPMN matrix is designed to explore relations between different types of elements. There are two types of BPMN 
matrices in Cameo Business Modeler:

• BPMN Resources Usage Matrices

• BPMN Data Usage Matrices

Related external resource
“Dependency Matrices” in MagicDraw UserManual.pdf

3.6.1 BPMN Resources Usage Matrices

Description
A BPMN Resources Usage Matrix is designed to review and edit an allocation of Resource Roles for BPMN 
Activities. The Resource Roles used in an Activity show a Resources property in a BPMN Activity specification 
dialog.

A BPMN Resources Usage Matrix presents information about BPMN Activities in rows and Resource Roles in 
columns. Each arrow in the matrix shows if a Resource Role is used by an Activity.

You can define Resource Roles usage for all BPMN Activities by assigning or removing the Resource Roles to or 
from the Activities.

Example

Figure -- BPMN Resource Usage Matrix
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Related elements
BPMN Process
Activities
Resource
Organization Unit
Role
Person
Information system
BPMN Matrices

Related procedure
Creating BPMN Resources Usage Matrix

3.6.2 BPMN Data Usage Matrices

Description
A BPMN Data Usage Matrix shows what data classes are used in BPMN Processes and SubProcess. Data 
Objects represents classes in a BPMN diagram.

A BPMN Data Usage Matrix presents information about all BPMN Processes and SubProcesses in rows and 
Classes in columns. Each row in the matrix shows if a class is used in a BPMN Process or SubProcess diagram 
as a Data Object.

Example

Figure -- BPMN Data Usage Matrix
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Related elements
BPMN Process
SubProcesses
Class
BPMN Matrices

Related diagram
BPMN Process Diagram

Related procedure
Creating BPMN Data Usage Matrix

3.7 BPMN Processes Structure Map
Description
A BPMN Processes Structure Map diagram allows you to represent the structure of processes in a project. The 
processes are grouped into packages on the diagram. And each process may itself contains other processes, 
which in turn may contain other processes. The diagram makes the processes easier to understand and helps you 
analyze how they are organized.

A BPMN Processes Structure Map diagram shows packages, processes, subprocesses, and tasks from a 
selected scope.

Example

Figure -- BPMN Processes Structure Map

Related elements
Package
BPMN Process
Activities

Related diagram
BPMN Process Diagram

Related external resource
“Relation Map” in MagicDraw UserManual.pdf
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4 USING CAMEO BUSINESS 
MODELER
This chapter provides the main procedures of Cameo Business Modeler and contains the following sections:

• Using Common BPMN Elements

• Using BPMN Process Diagram

• Using BPMN Collaboration Diagram

• Using BPMN Choreography Diagram

• Using BPMN Tables and Matrices

• Using Organization Structure Diagram

• Using BPMN Element Numbers

• Exporting Models to XPDL

• Exporting Models to BPMN2

• Importing from BPMN 1.1

• Integration with Cameo SOA+

4.1 Using Common BPMN Elements
Some BPMN elements can not be represented on any BPMN diagram. You can use these elements as data types 
for specifying values of other element properties. This kind of elements can be created in the Containment tree.

To create a BPMN element in the Containment tree

• Right-click a package in the Containment tree. On the shortcut menu, click New Element > BPMN 
Element, and select a BPMN element that you want to create.

To open an element Specification window

Do one of the following:
• Right-click a selected symbol and from shortcut menu, select Specification.

• Double-click a symbol on the Diagram pane or in the Model Browser.

• Select a symbol on the Diagram pane and press the ENTER key.

• The element Specification window opens when you add a model element to an owning model 
element in its Specification window. The second Specification window opens on top of the first. 
Use the Back to or Forward to arrow buttons for switching between windows.

Related element
Common BPMN Elements

Related external resource
“Specification Window” in MagicDraw UserManual.pdf
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4.2 Using BPMN Process Diagram

The following sections describe how to create and specify a BPMN Process diagram:

• Creating BPMN Process Diagram

• Creating and Using Tasks

• Creating and Using SubProcesses

• Using Activities

• Creating and Using an Event

• Creating and Using a Sequence Flow

• Creating and Using Data Items

• Navigation Between BPMN Diagrams

4.2.1 Creating BPMN Process Diagram

You can create a BPMN Process diagram from

• BPMN2 Diagrams toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Process diagram from the BPMN2 Diagrams toolbar

1. Click the button on the BPMN2 Diagrams toolbar.The Create Diagram dialog opens.
2. Type the name and select the owner of the BPMN Process diagram.

3. Click OK.

To create a new BPMN Process diagram from the main menu

1. On the main menu, click Diagrams > BPMN2 Diagrams > BPMN Process Diagrams. The 
BPMN Process Diagrams dialog opens.

2. Click the Create button. The Specification window opens.
3. Type the name and select the owner of the BPMN Process diagram.
4. Click OK.

To create a new BPMN Process diagram from the shortcut menu of a package in the Containment tree

1. Right-click the package in the Containment tree and from the shortcut menu, select New Diagram 
> BPMN2 Diagrams > BPMN Process Diagram.

2. Type the name for a created BPMN Process diagram.

A BPMN Process diagram can also contain the elements 
of a BPMN Collaboration diagram.

You can create a BPMN Process diagram only from the Business Modeler, 
Business Analyst, and Full Featured user perspectives.

The owner of Process diagram has to be a BPMN Process.
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Related diagram
BPMN Process Diagram

Related procedures
Creating and Using Tasks
Creating and Using SubProcesses
Using Activities
Creating and Using an Event
Creating and Using a Sequence Flow
Creating and Using Data Items
Navigation Between BPMN Diagrams

4.2.2 Creating and Using Tasks
There are multiple types of Tasks that you can create in a BPMN Process diagram.

To create a Task

1. Open a Process diagram.
2. On the diagram pallet, click the Task button and select a type of Task you need to create.

To change a task type

• Right-click a Task and select a new Task type.

Figure -- Changing Task type

Related element
Tasks

Related diagrams
BPMN Process Diagram
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BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using SubProcesses
Using Activities
Creating and Using an Event
Creating and Using a Sequence Flow
Creating and Using Data Items
Navigation Between BPMN Diagrams

4.2.3 Creating and Using SubProcesses
A BPMN diagram can display subprocesses with different symbol properties. They are as follows:

• An expanded SubProcess can contain inner shapes.

• A collapsed SubProcess cannot display inner shapes. A plus sign (+) marker will be displayed for 
a collapsed subprocess.

If the Is Triggered By Event property of a SubProcess is set to true, it will call an Event SubProcess and will be 
drawn with a dashed border.

There are two specific types of SubProcesses:

• Transaction SubProcess. It is represented with double borders.

• AdHoc SubProcess. It is represented with an AdHoc marker on its shape.

To create a SubProcess

1. Open a Process diagram.
2. On the diagram pallet, click the arrow next to the SubProcess and select needed type of 

SubProcess.

To expand a SubProcess

Do either:

Business Analyst perspective provide most popular SubProcess types. Full list of 
SubProcesses types you can have only in Business Modeler and Full Featured 
perspectives.
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• Right-click a SubProcess shape and from the shortcut menu select Symbol(s) Properties. Then 
in the Symbol Properties dialog click to clear the Suppress Content.

• Right-click a SubProcess shape and then on the shortcut menu click to clear Suppress Content.

To collapse SubProcess

Do either:
• Right-click a SubProcess shape and then on the shortcut menu click to select Suppress Content.
• Right-click a SubProcess shape and from the shortcut menu select Symbol(s) Properties. Then 

in the Symbol Properties dialog click to select the Suppress Content.

To mark a created SubProcess as an event SubProcess

Do either:
• Right-click the SubProcess and on the shortcut menu click to select Triggered By Event.
• Open the SubProcess Specification window. Select the Triggered By Event check box.

Figure -- Marking SubProcess as Event SubProcess

To convert a SubProcess to a Transaction SubProcess or AdHoc SubProcess

• Right-click the SubProcess and from the shortcut menu select Refactor > Convert To > More 
Specific > AdHoc SubProcess or Transaction SubProcess.

To convert a Transaction SubProcess or AdHoc SubProcess to a SubProcess

• Right-click the Ad Hoc SubProcess or Transaction SubProcess and from shortcut menu select 
Refactor > Convert To > More General> SubProcess.
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To display a Start Event icon on a Event SubProcess

1. Create an expanded Event SubProcess.
2. Create a Start Event to the Event SubProcess.
3. Right-click the SubProcess and click to select the Suppress Content check box.

Related element
SubProcesses

Related Diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Using Activities
Creating and Using an Event
Creating and Using a Sequence Flow
Creating and Using Data Items
Navigation Between BPMN Diagrams

4.2.4 Using Activities
This section will describe how to use Activities in a BPMN process diagram. Activities (Tasks, Subprocesses, and 
Call Activities) can have the following specific markers displayed on their shapes:

• Compensation

• Standard loop

• MultiInstance loop (parallel)

• MultiInstance loop (sequential)

To add a Compensation marker to an Activity

Do either:
• Right-click an Activity and select Is For Compensation.

• Open the Activity Specification window. Click to clear the Is For Compensation check box and 
click Close.

Figure -- Adding Compensation Marker to Activity

To add a Loop marker to an Activity

• Right-click an Activity and click to select Standard Loop or MultiInstance Loop.
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To display a MultiInstance Loop (sequential) marker on a MultiInstance Loop activity

Do either:
• Right-click an Activity with a MultiInstance Loop (parallel) marker and on the shortcut menu select 

Is Sequential.
• Open the Activity with a MultiInstance marker Specification window. Select Is Sequential and 

then click Close.

Figure -- Displaying MultiInstance Loop Marker on MultiInstance Loop Activity

To convert an Activity to another type of Activity

• Right-click a Task, SubProcess, or Call Activity and from the shortcut menu select Refactor > 
Convert To and then select an Activity type to which you need to convert the selected Activity.

To display Resources assigned for Activities

• Right-click the diagram pane and then do one of the following:

• On the shortcut menu, click to select the Show Assigned Resources check box (see 
the following figure).

• From the shortcut menu, select Diagram Properties and in the open dialog, set the 
Show Assigned Resources property value to true.

Related element
Activities

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Creating and Using SubProcesses
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Creating and Using an Event
Creating and Using a Sequence Flow
Creating and Using Data Items
To open an element Specification window
Navigation Between BPMN Diagrams

4.2.5 Creating and Using an Event
This section will describe how to create and specify Events in BPMN diagrams.

To create an Event

• On the Process diagram pallet, click a desired event button and then select a type of Event.

Figure -- Selecting to create new Start Event

To create a Boundary Event

1. On the Process diagram pallet, click the Boundary Event (Message) button and then select a 
type of Boundary Event.

2. Click an Activity or Choreography Activity in the diagram.

To change an Event type

• Right-click a created Event and select a new Event type.

You can change an Event type for Start, Intermediate, Boundary, 
or End Events.
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Figure -- Selecting new Event type on Event’s shortcut menu

To change a Start Event to non-interrupting

Do either:
• Right-click the Start Event and on the shortcut menu click Is Interrupting > False.

• Open the Start Event Specification window. It the Is Interrupting property box, select False and 
click Close.

Not all Start Event types can be non-interrupting. The command Is Interrupting 
is only available for the following Start Event types:

• Message Start Event
• Timer Start Event
• Escalation Start Event
• Conditional Start Event
• Signal Start Event
• Multiple Start Event
• Parallel Multiple Start Event
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To change a Boundary Event to non-interrupting

Do either:
• Right-click the Boundary Event and on the shortcut menu click Cancel Activity> False.

• Open the Boundary Event Specification window. In the Cancel Activity property box, select 
False, and then click Close.

Related elements
Start Events
Intermediate Catch Event
Intermediate Throwing Event
Boundary Events
End Events
Activities
Choreography Activities

Related diagrams 
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Creating and Using SubProcesses
Using Activities
Creating and Using a Sequence Flow
Creating and Using Data Items
To open an element Specification window

Not all Boundary Event types can be non-interrupting. The command Cancel 
Activity is only available for the following Boundary Event types:

• Message Boundary Event
• Timer Boundary Event
• Escalation Boundary Event
• Conditional Boundary Event
• Signal Boundary Event
• Multiple Boundary Event
• Parallel Multiple Boundary Event
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Navigation Between BPMN Diagrams

4.2.6 Creating and Using a Sequence Flow
A Sequence Flow connects Activities, Choreography Activities, Events, and Gateways. A Conditional Sequence 
Flow has a condition expression and is drawn with a mini-diamond marker at the beginning of the Sequence Flow.

A default Sequence Flow is indicated with a backslash at the beginning of the Sequence Flow.

To create a Sequence Flow

Do either:
• Click an Activity on the diagram. On the Smart Manipulators toolbar click the Sequence Flow 

button.

• Click the Sequence Flow button on the diagram pallet and connect appropriate shapes on the 
diagram pane.

To add a condition to Sequence Flow

Do either:
• Select the created Sequence Flow, open its Specification window and enter the Condition 

Expression property value.

• Select the created Sequence Flow and type the condition between the brackets.

To set a default Sequence Flow

1. Select the Sequence flow on the diagram pane.

A Conditional Sequence Flow outgoing from a Gateway is displayed without 
a mini diamond marker.

A default Sequence Flow can be specified for Activities (Tasks, Subprocesses, 
and Call Activities) or exclusive, inclusive, and complex Gateways.
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2. On the Smart Manipulator toolbar, click the Make Default button.

To change direction of Sequence Flow

• Right-click the Sequence Flow and from the shortcut menu, select Refactor > Reverse Direction.

Related element
Sequence Flow

BPMN Process Diagrams
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Creating and Using SubProcesses
Using Activities
Creating and Using an Event
Creating and Using Data Items
To open an element Specification window
Navigation Between BPMN Diagrams

4.2.7 Creating and Using Data Items
You can create the following data items in a BPMN Process diagram:

• Data Object

• Data Store

• Data Input and Data Output

You can mark a Data Object as a collection.

With a Data Association, you can connect a data item to other elements of the BPMN Process diagram.

A default Sequence flow does not have a condition expression.
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To create a data item

• On the Process diagram pallet, click Data Object and select needed Data item.

To create a new Data Object, which is typed by a classifier

• Select the classifier in the Containment tree and drag it to a BPMN Process or BPMN 
Collaboration diagram.

To specify a type of Data Item

Do either:
• In the Containment tree, select an element and drag it on the Data Item.

• Right-click the Data Item, from the shortcut menu, select Type and choose the needed type.

Business Analyst perspective provide most popular SubProcess types. Full list of 
SubProcesses types you can have only in Business Modeler and Full Featured 
perspectives.
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• Open the Specification window and select a Type.

To mark a Data Object as collection

Do one of the following:
• Right-click the Data Object and from the shortcut menu choose Is Collection > true.

• Open the Data Object Specification window, Is Collection property set to true.

To create a Data Association between two data items

1. On the Process diagram pallet, click the Data Association button.
2. On the diagram pane

• Click an element, which will be the source of the Data Association.

• Click an element, which will be the target of the Data Association.

To display a Data Object directly connected to a Sequence Flow

1. Draw a Data Association from an Activity to a Data Object.
2. Draw another Data Association from the Data Object to another Activity.
3. Draw a Sequence Flow from the first to the second Activity.

• The source or target of a Data Association can only be a Data Object, Data Store, 
Data Input, or Data Output.

• The other end of the Data Association should always be an activity or event.

A Data Object connected to a Sequence Flow is a visual shortcut of two Data Associations. 
In the model, the Data Associations still exist, and the Data Object connecting to the 
Sequence Flow will be displayed.
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4. Right-click the Data Object and select Show Connected to Sequence Flow from the shortcut 
menu.

Figure -- Displaying Data Object directly connected to Sequence Flow

Related element
Common BPMN Elements

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Creating and Using SubProcesses
Using Activities
Creating and Using an Event
Creating and Using a Sequence Flow
Navigation Between BPMN Diagrams
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4.2.8 Navigation Between BPMN Diagrams
You can navigate to 

• higher level BPMN diagrams

• related Process diagrams

To navigate to a higher level BPMN diagrams

• At the bottom left corner of the diagram pane, on the toolbar, click the button and select 
higher level BPMN diagram.

To navigate to a related Process diagrams

• At the bottom left corner of the diagram pane, on the toolbar, click the button and select 
related process diagram.

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Process Diagram
Creating and Using Tasks
Creating and Using SubProcesses
Using Activities
Creating and Using an Event
Creating and Using a Sequence Flow
Creating and Using Data Items

4.3 Using BPMN Collaboration Diagram

The following sections describe how to create and specify a BPMN Collaboration diagram.

• Creating BPMN Collaboration Diagram

A BPMN Collaboration diagram can contain the elements 
from a Process diagram.
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• Creating and Using Pool and Lanes

• Creating and Using Message Flow

• Creating and Using Conversation Nodes

• Creating and Using Participant

4.3.1 Creating BPMN Collaboration Diagram

You can create a BPMN Collaboration diagram from

• BPMN2 Diagrams toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Collaboration diagram from the BPMN2 Diagrams toolbar

1. Click the button on the BPMN2 Diagrams toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the BPMN Collaboration diagram.

3. Click OK.

To create a new BPMN Collaboration diagram from the main menu

1. On the main menu click Diagrams > BPMN2 Diagrams > BPMN Collaboration Diagram. The 
BPMN Collaboration Diagrams dialog opens.

2. Click the Create button. The Specification window opens.
3. Type the name and select the owner of the BPMN Collaboration diagram.
4. Click OK.

To create a new BPMN Collaboration diagram through the shortcut menu of a package in the Containment tree

1. Right-click a package in the Containment tree and from the shortcut menu, select New Diagram > 
BPMN2 Diagrams > BPMN Collaboration Diagram.

2. Type the name for the diagram.

Related diagram
BPMN Collaboration Diagram

Related procedures
Using BPMN Process Diagram
Creating and Using Pool and Lanes
Creating and Using Message Flow
Creating and Using Conversation Nodes
Creating and Using Participant
Navigation Between BPMN Diagrams

You can create a BPMN Collaboration diagram only from the Business Modeler, 
Business Analyst, and Full Featured user perspectives.

The owner of Collaboration diagram has to be a BPMN Collaboration.
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4.3.2 Creating and Using Pool and Lanes
A Pool in a BPMN collaboration diagram represents a participant of a collaboration. A Pool can have its inner 
process flows defined. You can add the elements from a BPMN Process diagram to a pool. You can also hide the 
pool details by displaying a “black box” pool. A Pool can also have inner lanes.

To create a Pool from Diagram pallet

1. On the Collaboration Diagram pallet, click Horizontal Pool and select a needed type of Pool.

2. Select Resources and click OK.

To create a Pool with a representing Resources from the Containment tree

• Drag a Resource, Organization, Post, or Person from the Containment tree to a BPMN 
Collaboration diagram pane.

To create a Pool with a suppressed content

• On the Collaboration Diagram pallet, under Conversations click Participant (Pool).

To add Lane to a Pool

Do either:
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• Right-click a Pool, point to Insert Inner Lanes or Insert Lanes and select a lane type.

• Right-click a Pool header and click to select Insert Lanes.

To open a Pool Specification window

• Right-click the Pool header and select Specification.

To specify a model element represented by a Pool or Lane

Do either:
• Click a Pool or Lane header on the diagram. On the Smart Manipulators toolbar click the 

Represents button.

A Pool can represent a BPMN Resource element or UML classifier element.
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• Open the Pool or Lane Specification window, click Represents and select the represented 
elements from drop down list.

• Select a represented element in the Containment tree and drag it to the Pool or Lane header on 
the diagram.

To hide a Pool content on a diagram (to display a “black box” pool)

• Right-click a Pool header and from the shortcut menu select one of the following:

• Suppress Pool Content
• Symbol(s) Properties and in the open dialog set the Suppress Pool Content 

property value to true.

A Pool with suppressed content that references a MultiInstance Participant will be displayed with a MultiInstance 
marker.

To display a MultiInstance marker on a Pool

1. Open the Specification window.
2. Click Represents and select a represented multi-instance Participant.

Any type of element you can select only from Specification window.

A MultiInstance marker can be displayed only on a Poll 
with suppressed contents.
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To review the Pool or Lane traceability information

• Open the Specification window, click Traceability.

Figure --  Pool Traceability information

Related elements
Resource
Participant
Pool and Lane
Organization Unit
Role
Person
Information system

Related diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Collaboration Diagram
Creating and Using Message Flow
Creating and Using Conversation Nodes
Creating and Using Participant
To open an element Specification window

4.3.3 Creating and Using Message Flow

To draw a Message Flow between two elements or Pools

Do either:
• On the Collaboration diagram pallet, click Message Flow button and connect appropriate shapes.
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• Select the Pool header and on the Smart manipulator toolbar, click the Message Flow button.

To create a new Message for a Message Flow, which is typed by a classifier, by using drag and drop operation

• Select the classifier (Class, Input Set, Output Set, or Error) in the Containment tree and drag it to 
a Message Flow on a Collaboration diagram.

To create a Message for a Message Flow from the Smart Manipulator toolbar

1. On the diagram pane, select a Message Flow path and on the Smart Manipulator toolbar, click the 
Referenced Messages button. The Select Message dialog opens.

2. Select a Collaboration where you want to create a new message and click the Creation Mode 
button.

3. Select a Collaboration element and click the Create button.

A Message Flow must connect two different Pools 
or inner elements of different Pools.

You can create a Message in a BPMN Process, Collaboration, 
Choreography, or SubProcess element.
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4. Click OK.

Figure -- Creating Collaboration element in Select Message dialog

To change a Message display mode

• Right-click a Message Flow and from the shortcut menu select one of the following:

• Show Message and select a message display mode.

• Symbol(s) Properties and select the needed Show Message property value.

To change direction of Message Flow

• Right-click the Message Flow and from the shortcut menu, select Refactor > Reverse Direction.

Related elements
Message
Message Flow
Pool and Lane

Related diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Collaboration Diagram
Creating and Using Pool and Lanes
Creating and Using Conversation Nodes
Creating and Using Participant

4.3.4 Creating and Using Conversation Nodes
A Conversation groups messages exchanged among collaboration participants.
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To create a Communication between two Pools

1. Create a Conversation and Pool.
2. Create a Conversation Link from the Conversation to a Pool.
3. Draw another Conversation Link from the Conversation to another Pool.

To select Message Flows grouped by a Conversation

1. Do either:
• Open the Conversation shape Specification window. Select the Message Flow Refs 

property value cell and then click the ... button.

• Select a Communication shape and on the Smart Manipulator toolbar, click the 
Message Flows button.

The Select Message Flows dialog opens.It shows all Message Flows that are grouped by a 
Conversation.

Figure -- Displaying Message Flows in Select Message Flows dialog

2. Select one or more Message Flows and click OK.

A Pool requires a specified Representing Resource.

When the Show Message Flows Related to Participants check box 
is selected, only the message flows that exist in a project between the 
Representing Participants of the pools connected by a Conversation 
will show.

Click to clear the check box to see all message flows in a project.
You can also assign a Message Flow to a Conversation by dragging it from the 
Containment tree to a Conversation shape on the BPMN Collaboration diagram.
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To create a SubConversation

• On the diagram pallet, click SubConversation.

A SubConversation can contain inner Conversation Nodes (Conversation and SubConversation).

To create a Conversation Node for a SubConversation

Do either:
• Select SubConversation and on the Smart manipulator toolbar, click the SubConversation button.

• Open the Specification window, select Conversation Nodes in the property group list on the left. 
Click the Create button and select a Node type. Type the name and click Close.

Figure -- Creating Conversation Node in SubConversation Specification window

A CallConversation can reference Collaboration or Global Conversation.
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To create a CallConversation

• On the diagram pallet, click SubConversation.

Related elements
Conversation
SubConversation
Call Conversation
Message
Message Flow
Pool and Lane

Related diagram
BPMN Collaboration Diagram

Related procedures
Creating BPMN Collaboration Diagram
Creating and Using Pool and Lanes
Creating and Using Message Flow
Creating and Using Participant

4.3.5 Creating and Using Participant

To create a Participant

• Right-click the BPMN Collaboration or Choreography element in the Containment tree and from 
the shortcut menu, select New Element > BPMN Element > Participant.

To create a multi-instance Participant

1. Right-click a created Participant in the Containment tree and select Specification from the 
shortcut menu. The Participant Specification window opens.

2. In the Participant Specification window, under the Multiplicity category in the General property 
group, type the Minimum property value (“2” or greater).

Related elements
Participant
Pool and Lane
Choreography Activities

The Minimum Multiplicity value of a MultiInstance participant property 
must be “2” or greater.
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Related diagrams
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedures
Using BPMN Collaboration Diagram
Using BPMN Choreography Diagram

4.4 Using BPMN Choreography Diagram
The following sections describe how to create and specify a a BPMN Choreography diagram:

• Creating BPMN Choreography Diagram

• Using Choreography Activity

• Creating and Using Choreography Task

• Creating SubChoreography

• Creating Call Choreography Activity

4.4.1 Creating BPMN Choreography Diagram

You can create a BPMN Choreography diagram from 

• BPMN2 Diagrams toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Choreography diagram from the BPMN2 Diagrams toolbar

1. Click the  button on the BPMN2 Diagram toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the Choreography diagram.

3. Click OK.

To create a new BPMN Choreography diagram from the main menu

1. On the main menu, click Diagrams > BPMN2 Diagrams > BPMN Choreography Diagrams. The 
BPMN Choreography Diagrams dialog opens.

2. Click the Create button. The Specification window opens.
3. Type the name and select the owner of the BPMN Choreography diagram.
4. Click OK.

To create a new BPMN Choreography diagram from the shortcut menu of the package in the Containment tree

1. Right-click the package in the Containment tree and from the shortcut menu, select New Diagram 
> BPMN2 Diagrams > BPMN Choreography Diagram.

You can create a BPMN Choreography diagram only in the Business Modeler 
or the Full Featured perspective.

The owner of Choreography diagram has to be a BPMN Choreography.
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2. Type the name for the BPMN Choreography diagram.

Related element
Choreography

Related diagram
BPMN Choreography Diagram

Related procedures
Using Choreography Activity
Creating and Using Choreography Task
Creating SubChoreography
Creating Call Choreography Activity
Navigation Between BPMN Diagrams

4.4.2 Using Choreography Activity
This section describes how to create and model choreography activities in a BPMN Choreography diagram. You 
can specify a list of Participants in a Choreography Activity from

• Specification window

• Smart Manipulator toolbar

• Drag-and-drop operation

To specify a list of Participants from the Specification window

1. Do either:
• Select the Choreography Activity on the diagram pane and on the Smart Manipulator 

toolbar, click the Participants button.

• Open the Specification window, click the Participants property value cell and then 
click ... button.

The Select Recourse dialog opens.
2. In the open dialog, select Resources.
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3. Click OK.

Figure -- Selecting Resources in Select Resource dialog

To specify a list of participants from the drag-and-drop action

• Drag a Resource from the Containment tree to a Choreography Activity on diagram pane.

To specify an Initiating Participant in a Choreography Activity

1. Open the Choreography Activity Specification window. 

You need to specify at least two Participants for a Choreography 
Activity.

The MultiInstance Participants on a Choreography shape will be displayed with 
a MultiInstance marker in the Participants’ compartment.

• Hold down SHIFT to select multiple elements that are grouped together.
• Hold down CTRL to select multiple elements that are not grouped together.

A Choreography Activity needs the Initiating Participant property value 
to be specified.
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2. Click the Initiating Participant property value cell and select a Resource.

To add a Loop marker to a Choreography Activity

• Right-click a Choreography Activity and select Standard Loop or MultiInstance Loop.

To display a MultiInsatance Loop (sequential) marker on a MultiInstane Loop Choreography Activity

Do either:
• Right-click a Choreography Activity with the MultiInstance Loop (parallel) marker and select Is 

Sequential.
• Open the Choreography Activity with the MultiInstance Loop marker Specification window. Select 

the Is Sequential check box.

Related elements
Choreography Activities
Participant
Resource

Related diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Choreography Diagram
Creating and Using Choreography Task
Creating SubChoreography
Creating Call Choreography Activity
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Creating and Using Participant
To open an element Specification window

4.4.3 Creating and Using Choreography Task
A Choreography Task can have references to Message Flows, existing among referenced Resources.

To create a Choreography Task

• On the diagram pallet, click Choreography Task.

To select Message Flows referenced by a Choreography Task

1. Open the Choreography Task Specification window. 
2. Select Message Flow property value cell and click the ... button. The Select Message Flows 

dialog opens.
3. Select the Message Flows and click OK.

Figure -- Selecting Message Flows

If the Message Flows, which are referenced by a Choreography Task, have the Messages 
specified, they will be displayed and attached to the Choreography Task in the diagram.
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To specify Messages for a Choreography Task

1. Create a BPMN Collaboration diagram with Pools representing Resources and Message Flows 
with Messages.

Figure -- Pools, Resources, and Message Flow

2. On a BPMN Choreography diagram and create Choreography Task.
3. Open the Choreography Task Specification window. Specify the Participants for the Participant 

Refs property and a Participant for the Initiating Participant Ref property.
4. Select the Message Flow property and click the ... button. The Select Message Flows dialog 

opens. Select the Message Flows you have created in step 3 as the Message Flow property 
value and click Close.

To hide the Messages for a Choreography Task

Do either:
• Right-click a Choreography Task and select Show Messages.

• Right-click a Choreography Task and click Symbol(s) Properties. The Symbol Properties dialog 
opens. Select Show Messages.

• Initiating Messages (connected to an initiating Participant compartment) will be 
displayed in yellow.

• Non-initiating messages (connected to a non-initiating Participant compartment) 
will be displayed in gray.
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Related elements
Choreography Task
Resource
Participant
Message
Collaboration

Related diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Choreography Diagram
Using Choreography Activity
Creating SubChoreography
Creating Call Choreography Activity
Creating and Using Pool and Lanes
Creating and Using Message Flow
To open an element Specification window

4.4.4 Creating SubChoreography
A SubChoreography can be displayed with different symbol properties:

• An Expanded SubChoreography can contain inner shapes.

• A Collapsed SubChoreography cannot display inner shapes. A plus sign (+) marker is displayed 
for a collapsed subprocess.

To create SubChoreography

• On the Choreography diagram pallet, click SubChoreography and select a needed 
SubChoreography.

To expand a SubChoreography

Do either:
• Right-click a SubChoreography and on the shortcut menu select Suppress Content.
• Right-click a SubChoreography and select Symbol(s) Properties. The Symbol Properties 

dialog opens. Select or clear the Suppress Content and click OK.

To collapse a SubChoreography

Do either:
• Right-click a SubChoreography and on the shortcut menu clear the Suppress Content.
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• Right-click a SubChoreography and select Symbol(s) Properties. The Symbol Properties 
dialog opens. Clear the Suppress Content and click OK.

Related element
SubChoreography

Related diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Choreography Diagram
Using Choreography Activity
Creating and Using Choreography Task
Creating Call Choreography Activity

4.4.5 Creating Call Choreography Activity

A Call Choreography Activity holds a reference to a Choreography.

To create a Call Choreography Activity

1. On the diagram pallet, click Call Choreography Activity. The Select Behavior dialog opens.

2. Select a Choreography Activity.
3. Click OK.

Business Analyst perspective provide most popular Call Choreography 
types. Full list of Call Choreography types you can have only in Business 
Modeler and Full Featured perspectives.
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To change the element called by a Call Choreography Activity

Do either:
• Right-click a Call Choreography Activity and click Called Choreography Ref. Select a 

Choreography from the elements list.

• Open the Call Choreography Activity Specification window. Click Called Choreography Ref and 
select a Choreography as property value.

Related element
Call Choreography

Related diagram
BPMN Choreography Diagram

Related procedures
Creating BPMN Choreography Diagram
Using Choreography Activity
Creating and Using Choreography Task
Creating SubChoreography
Creating Call Choreography Activity
To open an element Specification window

4.5 Using BPMN Tables and Matrices
The following sections describe how to create and use a BPMN tables and matrices:

• Creating BPMN Processes Description Table

• Creating BPMN Resources Description Table

• Creating BPMN Business Data Description Table

• Creating BPMN Activities Description Table

• Modifying BPMN Table

• Creating BPMN Resources Usage Matrix

• Creating BPMN Data Usage Matrix

• Modifying BPMN Matrices

4.5.1 Creating BPMN Processes Description Table

You can create a BPMN Processes Description Table from

• BPMN Tables and Matrices toolbar

• main menu

• shortcut menu of a package in the Containment tree

You can create a BPMN Processes Description Table only from the Business Analyst, 
Business Modeler, and Full Featured perspectives.
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To create a new BPMN Processes Description Table from the BPMN Tables and Matrices toolbar

1. Click the button on the BPMN Tables and Matrices toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the BPMN Processes Description Table.
3. Click OK.

To create a new BPMN Processes Description Table from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices > BPMN Processes 
Description Tables. The BPMN Processes Description Tables dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Processes Description Table.
4. Click OK.

To create a new BPMN Processes Description Table from the shortcut menu of the package in the Containment 
tree

1. Right-click a package in the Containment tree and from the shortcut menu, select New Diagram > 
BPMN Tables and Matrices > BPMN Processes Description Table.

2. Type the name for the created BPMN Processes Description Table.

Related element
BPMN Process

Related diagram
BPMN Processes Description Table

Related procedure
Modifying BPMN Table

4.5.2 Creating BPMN Resources Description Table

You can create a BPMN Resources Description Table from

• BPMN Tables and Matrices toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Resources Description Table from the BPMN Tables and Matrices toolbar

1. Click the button on the BPMN Tables and Matrices toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner for the BPMN Resources Description Table.
3. Click OK.

To create a new BPMN Resources Description Table from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices > BPMN Resources 
Description Tables. The BPMN Resources Description Tables dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Resources Description Table.
4. Click OK.

You can create a BPMN Resources Description Table only from the Business Analyst, 
Business Modeler, and Full Featured user perspectives.
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To create a new BPMN Resources Description Table from the shortcut menu of a package in the Containment 
tree

1. Right-click a package the Containment tree and from the shortcut menu, select New Diagram > 
BPMN Tables and Matrices > BPMN Resources Description Table.

2. Type the name for a created BPMN Resources Description Table.

Related elements
Resource
Organization Unit
Role
Person
Information system

Related diagram
BPMN Resources Description Table

Related procedure
Modifying BPMN Table

4.5.3 Creating BPMN Business Data Description Table

You can create a BPMN Business Data Description Table from

• BPMN Tables and Matrices toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Business Data Description Table from the BPMN Tables and Matrices toolbar

1. Click the  button on the BPMN Tables and Matrices toolbar. The Create Diagram dialog 
opens.

2. Type the name and select the owner on the BPMN Business Data Description Table.
3. Click OK.

To create a new BPMN Business Data Description Table from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices > BPMN Business Data 
Description Tables. The BPMN Business Data Description Tables dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Business Data Description Table.
4. Click OK.

To create a new BPMN Business Data Description Table from the shortcut menu of a package in the Containment 
tree

1. Right-click a package the Containment tree and from the shortcut menu, select New Diagram > 
BPMN Tables and Matrices > BPMN Business Data Description Table.

2. Type the name for a created BPMN Business Data Description Table.

You can create a BPMN Business Data Description Table only from the Business 
Analyst, Business Modeler, and Full Featured user perspectives.
Copyright © 2009-2015 No Magic, Inc.147                                                                                                                                                  



Using BPMN Tables and Matrices
Related element
Class

Related diagram
BPMN Business Data Description Table

Related procedure
Modifying BPMN Table

4.5.4 Creating BPMN Activities Description Table

• You can create a BPMN Activities Description Table from 

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Activities Description Table from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices > BPMN Activities 
Description Tables. The BPMN Activities Description Tables dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Activities Description Table.
4. Click OK.

To create a new BPMN Activities Description Table from the shortcut menu of the package in the Containment 
tree

1. Right-click a package of the BPMN Process or Choreography diagrams in the Containment tree, 
select New Diagram > BPMN Tables and Matrices > BPMN Activities Description Table.

2. Type the name for a created BPMN Activities Description Table.

Related element
Activities

Related diagram
BPMN Activities Description Table

Related procedure
Modifying BPMN Table

You can create a BPMN Activities Description Table only from the Business Analyst, 
Business Modeler and Full Featured user perspectives.

BPMN Activities Description Table is recommended to be created inside 
a BPMN Process or Choreography.
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4.5.5 Modifying BPMN Table

To create a new element in a BPMN table

• Click the Add New button on the Table Edit toolbar.

To add an existing element to a BPMN table

Do either:
• In the Containment tree, select one or more Resources and drag them to the table.

• Click the Add Existing button on the Table Edit toolbar. The select element dialog opens, select 
element you need to add to the table and click OK.

To remove an element from a BPMN table

• Select the element in the table and click the Delete From Table button on the Table Edit toolbar.

• Hold down SHIFT to select multiple elements that are grouped together.
• Hold down CTRL to select multiple elements that are not grouped 

together.

To select more than one element, click the Multiple Selection 
button.
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To delete an element from both a BPMN table and the model

• Select the element in the table and click the Delete button on the Table Edit toolbar.

To display columns of the table

1. On the Table Edit toolbar, click Show Columns.
2. From the menu, select properties to be shown in the table.

To edit element property value in a cell

1. Click a cell.
2. Do either:

• Edit the value directly in the selected cell.

• Click the  button. The property value editor dialog opens.

To export a BPMN table to the *.html, *.csv, or *.xlsx format

1. On the BPMN table toolbar, click Export. The Choose file dialog opens.
2. Do either:

• Browse for a location to save a table in.

• Type the exported table name.

• Select the exported table format.

3. Click Save.

Related procedures
Creating BPMN Processes Description Table
Creating BPMN Resources Description Table
Creating BPMN Business Data Description Table
Creating BPMN Activities Description Table

Related external resource
“Generic Table” in MagicDraw UserManual.pdf

The property can be edited if it is not locked.
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4.5.6 Creating BPMN Resources Usage Matrix

You can create a BPMN Resources Usage Matrix from

• BPMN Tables and Matrices toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new BPMN Resources Usage Matrix from the BPMN Tables and Matrices toolbar

1. Click the  button on the BPMN Tables and Matrices toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the BPMN Resources Usage matrix.
3. Click OK.

To create a new BPMN Resources Usage Matrix from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices > BPMN Resources Usage 
Matrices. The BPMN Resources Usage Matrices dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Resources Usage Matrix.
4. Click OK.

To create a new BPMN Resources Usage Matrix from the shortcut menu of the package in the Containment tree

1. Right-click a package in the Containment tree and from the shortcut menu, select New Diagram > 
BPMN Tables and Matrices > BPMN Resources Usage Matrix.

2. Type the name for the created BPMN Resources Usage Matrix.

Related elements
Activities
Resource

Related diagram
BPMN Resources Usage Matrices

Related procedure
Modifying BPMN Matrices

4.5.7 Creating BPMN Data Usage Matrix

You can create a BPMN Data Usage Matrix from

• BPMN Tables and Matrices toolbar

• main menu

• shortcut menu of a package in the Containment tree

You can create a BPMN Resources Usage Matrix only from the Business Analyst, 
Business Modeler, and Full Featured user perspectives.

You can create a BPMN Data Usage Matrix only from the Business Analyst, Business 
Modeler, and Full Featured user perspectives.
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To create a new BPMN Data Usage Matrix from the BPMN Tables and Matrices toolbar

1. Click the button on the BPMN Tables and Matrices toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the BPMN Data Usage matrix
3. Click OK.

To create a new BPMN Data Usage Matrix from the main menu

1. On the main menu, click Diagrams > BPMN Tables and Matrices> BPMN Data Usage Matrices. 
The BPMN Data Usage Matrices dialog opens.

2. Click the Create button. The Create Diagram Specification window opens.
3. Type the name and select the owner of the BPMN Data Usage Matrix.
4. Click OK.

To create a new BPMN Data Usage Matrix from the shortcut menu of the package in the Containment tree

1. Right-click a package in the Containment tree and from the shortcut menu, select New Diagram > 
BPMN Tables and Matrices > BPMN Data Usage Matrix.

2. Type the name for the created BPMN Resources Usage Matrix.

Related elements
Activities
Data Object
Class

Related diagram
BPMN Data Usage Matrices

Related procedure
Modifying BPMN Matrices

4.5.8 Modifying BPMN Matrices

To change a row/column scope

Do either:
• In the Model Browser, select one or more elements you wish to see on your matrix and drag them 

to the Row Scope/Column Scope box in the Criteria area.

• Click the ... button next to the Row Scope/Column Scope box and in the opened dialog select 
what elements you wish to see on your matrix. Click OK.

To change resource assignment to an Activity for BPMN Resources Usage Matrix

Do either:
• Double-click the cell to create/remove a relationship between Activity and resource.

• Right-click the cell and from the shortcut menu select Resource.

To save a BPMN Matrices as *.csv

• On the BPMN Matrix toolbar, click the button to save your matrix as a Comma Separated 
Values ( .csv) file. The file can be opened with MS Excel.
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Related diagrams
BPMN Resources Usage Matrices
BPMN Data Usage Matrices

Related procedures
Creating BPMN Resources Usage Matrix
Creating BPMN Data Usage Matrix

Related external resource
“Dependency Matrix” in MagicDraw UserManual.pdf

4.6 Using Organization Structure Diagram
The following sections describe how to create and use a Organization Structure diagram.

• Creating Organization Structure Diagram

• Creating and Using Resources

4.6.1 Creating Organization Structure Diagram

You can create an Organization Structure diagram from 

• BPMN2 Diagrams toolbar

• main menu

• shortcut menu of a package in the Containment tree

To create a new Organization Structure diagram from the BPMN2 Diagrams toolbar

1. Click the  button on the BPMN2 Diagram toolbar. The Create Diagram dialog opens.
2. Type the name and select the owner of the Organization Structure diagram.
3. Click OK.

To create a new Organization Structure diagram from the main menu

1. On the main menu, click Diagrams > BPMN2 Diagrams > Organization Structure Diagrams. 
The Organization Structure Diagrams dialog opens.

2. Click the Create button. The Specification window opens.
3. Type the name and select the owner of the Organization Structure diagram.
4. Click OK.

To create a new Organization Structure diagram from the shortcut menu of the package in the Containment tree

1. Right-click the package in the Containment tree and from the shortcut menu, select New Diagram 
> BPMN2 Diagrams > BPMN Organization Structure Diagram.

2. Type the name for the Organization Structure diagram.

Related elements
Resource

You can create an Organization Structure diagram only in the Business Modeler 
or the Full Featured perspective.
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Organization Unit
Role
Person
Information system

Related diagram
Organization Structure Diagram

Related procedure
Creating and Using Resources

4.6.2 Creating and Using Resources
You can create a Resource inside a package. The Resource is not displayed on a BPMN2 diagram as it is 
represented by a Pool, Data Object, and Choreography Task.

To create a Resource on a Organization Structure diagram

• On the Organization Structure Diagram pallet, click the Resource button.

To create a Resource in the Containment tree

• Right-click a package in the Containment tree. On the shortcut menu, click New Element > BPMN 
Element > Resource.

To change a type of Resource

• Right-click the Resource and on the shortcut menu select needed Resource type.
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To review traceability information related to a Resource

1. Right-click a created Resource in the Containment tree and click Specification to open the 
Resource Specification window.

2. In the Resource Specification window, select Traceability.

Figure -- Traceability information of Resource

Related elements
Resource
Organization Unit
Role
Person
Information system

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related procedure
Using BPMN Element Numbers

4.7 Using BPMN Element Numbers
Most BPMN elements can have specified their IDs. Element ID is automatically created for BPMN Process, 
Collaboration, and Choreography diagram flow elements and conversations. The element IDs are displayed (in 
gray) in the following places:
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• On a diagram. The ID is displayed above or before the name of element.

• In the Model Browser. The ID is displayed in front of the name of element. 

• In the Specification window. The ID is below the Name property.

To specify or change a BPMN element’s ID manually

1. Open the Specification window of element.
2. Type a number in the Id property value box.

To turn on/off automatic elements numbering in a project

1. On the main menu, click Options > Project. The Project Options dialog opens.
2. In the Project Options dialog, click General project options in the options list on the left.
3. Click to clear the Use Element Auto-numbering check box and then click OK.

Figure -- Use Element Auto-numbering property in Project Options dialog

To hide an element Id on a diagram

• Right-click the diagram pane and then do one of the following:

• On the shortcut menu clear the Show Elements Id.
• From the shortcut menu, select Diagram Properties. Clear the Show Elements Id 

check box.

Automatic elements numbering is turned off in all the projects that are created using 
BPMN2 Project and BPMN-SoaML Project templates.
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To hide element numbers in the Containment tree

1. On the main menu, click Options > Project. The Project Options dialog opens.
2. In the Project Options dialog, click General project options in the options list on the left.
3. Click to clear the Display Element Number check box and then click OK.

To edit elements numbering

1. Right-click an element on the BPMN2 diagram and select Element Numbering from the shortcut 
menu. The Element Numbering dialog opens.

2. Change elements numbers into desired ones at the right side in this dialog.
3. Click OK.

To change displayed numbering style for element symbols on a diagram

1. Right-click an element on the BPMN2 diagram and select Symbol(s) Properties.
2. In the Symbol Properties dialog, select the Element Number Display Mode property value from 

the drop-down list.
3. Select the Show Number Tag Name check box to show prefix id = before an element number.

Related element
Numbering Elements
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Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

Related external resource
“Generic numbering mechanism” in MagicDraw UserManual.pdf
“Creating Numbering Customizations” in MagicDraw UML Profiling and DSL UserGuide.pdf

4.8 Exporting Models to XPDL
Cameo Business Modeler plugin for MagicDraw supports BPMN 2.0 model export to XPDL 2.2.

The support for XPDL 2.2 allows you to export your BPMN Processes and Collaborations to XPDL 2.2 format. A 
separate XPDL file is then created for each exported BPMN Process or Collaboration diagram.

To export multiple BPMN Processes or Collaborations to XPDL

1. On the main menu, click File> Export To > XPDL File. The Export to XPDL dialog opens.

Figure -- Exporting Multiple BPMN Processes or Collaborations to XPDL

2. Select the Selected BPMN Processes/Collaborations option button and choose the diagrams 
you want to export from the BPMN Processes/Collaborations list.

3. Click the ... button next to the Working Directory box to specify the place for saving the exporting 
project.

4. Click Save.

• XPDL 2.2 does not support BPMN Choreography and Conversation elements 
from BPMN Collaborations.

•

Press and hold down the Ctrl key to select multiple BPMN Processes 
or Collaborations.
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To export an active BPMN Process or Collaboration to XPDL

1. Do either:
• On the main menu, click File > Export To > XPDL File.

• Right-click the BPMN Process or Collaboration diagram in the Containment tree and 
from the shortcut menu, select Tools > Export To XPDL File.

The Export to XPDL dialog opens.

Figure -- Exporting selected BPMN Process/Collaboration diagram to XPDL

2. Select the Active BPMN Process/Collaboration option button.
3. Do either:

• Type the name for a destination directory in the Xpdl File box.

• Click the ... button next to the Working Directory box to specify the place for saving 
the exporting project.

4. Click Save.

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

4.9 Exporting Models to BPMN2
Cameo Business Modeler plugin for MagicDraw supports BPMN model export to BPMN2.

The support allows you to export your BPMN Processes, Collaborations or Choreographies to BPMN2 file.
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To export BPMN Processes, Collaborations or Choreographies to BPMN2

1. On the main menu, click File> Export To > BPMN2 File. The Export to BPMN2 File dialog 
opens.

2. Select the Selected BPMN Processes/Collaborations/Choreographies option button and 
choose the diagrams you want to export from the BPMN Processes/Collaborations list.

3. Click the ... button next to the Working Directory box to specify the place for saving the exported 
file.

4. Click Save.

To export an active BPMN Process, Collaboration or Choreographies to BPMN2

1. Do either:
• On the main menu, click File > Export To > BPMN2 File.

• Right-click the BPMN Process or Collaboration diagram in the Containment tree and 
from the shortcut menu, select Tools > Export To BPMN2 File.

Press and hold down the Ctrl key to select multiple BPMN Processes 
or Collaborations.
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The Export to XPDL dialog opens.

2. Select the Active BPMN Process/Collaboration/Choreographies option button.
3. Click the ... button next to the BPMN2 File box to specify the place for saving the exporting 

project.
4. Click Save.

Related element
BPMN2 XML support

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram
BPMN Choreography Diagram

4.10 Importing from BPMN 1.1
The MagicDraw 16.8 and its earlier versions support BPMN 1.1 and Business Process diagrams, this let you to 
model business processes using the BPMN 1.1 notation.

You can convert your MagicDraw projects containing old BPMN profile and Business Process diagrams to the new 
BPMN 2.0 standard. A backup file will be created for the project conversion. This backup file lets you to find your 
BPMN 1.1 models when you need them.

The support for BPMN 1.1 and Business Process diagrams is no longer available 
from MagicDraw version 17.0.1. It is replaced by the Cameo Business Modeler 
support for the BPMN 2.0 specification.
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To convert a BPMN 1.1 project to BPMN 2.0 by opening it

1. Open a MagicDraw project that contains a BPMN Profile or Business Process diagram. A 
Question dialog opens.

2. Click Yes to convert the project.
3. Click OK.

To convert a BPMN 1.1 project to BPMN 2.0 by importing it

1. On the main menu, click File > Import From > BPMN 1.1 Project. The Open BPMN 1.1 Project 
dialog opens.

2. Select a project that contains a Business Process diagram and click Open.
3. Click OK.

To convert a Teamwork BPMN 1.1 project to BPMN 2.0

1. On the main menu, click File > Import From > BPMN 1.1 Project. A Question dialog opens.
2. Click Yes to convert the project. Another Question dialog opens to inform you that all elements 

will be locked.
3. Click Yes.

4.11 Integration with Cameo SOA+
The BPMN and SoaML standards complement each other. They both describe organizations, information, and 
behavior from different perspectives: SoaML defines the structure of collaborating systems, and BPMN describes 
the dynamic behavior.

The Cameo Business Process Modeler integrated with Cameo SOA + Plugin allows you to use the BPMN and 
SoaML standards together. The advantages of using SoaML elements are as following:

• A BPMN Pool can represent an SoaML Participant.

A backup file project_name_bpmn1.1.bak is created when the project has been migrated. 
The file includes the BPMN 1.1 project before the migration.

Before migrating a Teamwork BPMN 1.1 project to BPMN 2.0, make sure that other users 
have not locked the BPMN elements.

A backup file for a Teamwork project will not be created when migrating the project to 
BPMN 2.0. Use a Teamwork version as a backup copy that has included the BPMN 1.1 
Business Process diagrams before migrating the project.

Cameo SOA+ Plugin have to be installed in order to use the BPMN 
and SoaML standards together.
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• SoaML elements can be selected as the BPMN Data Object type.

• SoaML elements can be selected as the BPMN Message type.

• BPMN Elements can be traced to SoaML elements.

• SoaML elements can be traced to BPMN elements.

To create a new BPMN-SoaML project

1. Do either:
• On the main menu, click File > New Project. 
• On the File toolbar, click the  button.

• Press Ctrl + N. 

The New Project dialog opens. 
2. Click BPMN2-SoaML Project.

3. Type the project name in the Name box.
4. Click the ... button to select the location to store the newly created project.
5. Click OK.

To use the SoaML concepts in an existing BPMN2 project

1. On the main menu, click File > Use Module. The Use Module dialog opens.
2. Select the BPMN-SOAML Integration Profile.mdzip module file.
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3. Click Finish.

Figure -- Use Module dialog

To create a pool that represents an SoaML participant

1. Create a Pool in the BPMN Process or BPMN Collaboration diagram.
2. Select an SoaML Participant as the Participant referenced by a Pool.

To select an SoaML element as a BPMN Data Object type

1. Create a Data Object in the BPMN Process or BPMN Collaboration diagram.
2. Open the Data Object Specification window.
3. Select an SoaML element as the property Type value.

To create a Message typed by an SoaML element as a Message Flow

1. Select a Message Flow on the BPMN Collaboration or BPMN Process diagram, then on the Smart 
Manipulator toolbar, click the Referenced Message button.

2. Create a new Message.
3. Open the Message Specification window.
4. Select a SoaML element as the property Type value.

The Traceability relations between the BPMN and SoaML elements can be reviewed and defined in the Element 
Specification window, BPMN-SOAML Traceability property group. The BPMN-SOAML Traceability property 
group is available for the following elements:

• BPMN Activities

• Events
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• Gateways

• Data Objects

• SoaML and UML Classifiers

• Ports

Types of traceability relations defined in MagicDraw are as following: 

• Relations to BPMN model elements

• Relations to SoaML model elements

The BPMN-SoaML traceability relations to BPMN elements that are available in MagicDraw are listed in the table.

The BPMN-SoaML traceability relations to SoaML elements that are available in MagicDraw are listed in the table.

Property name Function
BPMN Choregraphy 
Diagrams

To select the BPMN Choreography diagrams that describe the current element.

BPMN Collaboration 
Diagrams

To select the BPMN Collaboration diagrams that describe the current element.

BPMN Interface To select the BPMN Interfaces that correspond to the current element.

BPMN Participants To select the BPMN Participants that correspond to the current element.

Choreography To select the BPMN Choreographies that describe the current element.

Collaboration To select the BPMN Collaborations that describe the current element.

Property name Function
Interface To select the Interface that is related to the current element.

Request Points To select the SoaML Request Points that are related to current element.

Service Interface To select the SoaML Service Interfaces that are related to the current element.

Service Points To select the SoaML Service Points that are related to the current element.
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To review or define BPMN-SoaML element traceability relations

• Open the Element Specification window and click BPMN/SOAML Traceability in the tree at the 
left-hand side.

Figure -- BPMN/SOAML Traceability tab in Element Specification window
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Integration with Cameo SOA+
To review the Lanes that represent SoaML Participants

• Open the SoaML Participant Specification window. The Property Representing Pools shows all 
the Lanes that represent SoaML Participants.

Figure -- Representing Lanes in SoaML Participant Specification window

Related element
Common BPMN Elements

Related diagrams
BPMN Process Diagram
BPMN Collaboration Diagram

Related procedures
To specify a model element represented by a Pool or Lane
To create a Message for a Message Flow from the Smart Manipulator toolbar
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5 APPENDIX I :  VALIDATION 
RULES
168                                                                              

5.1 Incoming Sequence Flow is not created for End 
Event
Abbreviation

COM3001

Description

An end event is detected without the connected incoming sequence flow. Each end event should have at least one 
incoming sequence flow.

Severity

Warning

Context Element

End Event

Solution

Create an incoming sequence flow for the validated end event.

Abbreviation Validation Rule
COM3001 Incoming Sequence Flow is not created for End Event

COM3002 Error code is not specified for an Error or Error is not defined for an Error End Event

COM3003 Too few outgoing Sequence Flow are detected for an Event-Based Gateway

COM3004 A Start Event is not defined for an Event SubProcess

COM3005 An Intermediate Boundary Event does not have outgoing Sequence Flow

COM3006 Incoming/outgoing Sequence Flow is missing for an Intermediate Catch Event

COM3007 Incoming/outgoing Sequence Flow is missing for an Intermediate Throw Event

COM3008 Outgoing Sequence Flow is not defined for a Start Event

COM3009 Resource is not defined for a Task

COM3010 Incoming/outgoing Sequence Flow is missing for a Task

COM3011 Name is not defined for a Task

COM3012 Type is not defined for a Data Object, Data Input, Data Output and Data Store

COM3013 A Representer is not specified for a Lane

COM3014 A Documentation is not specified for a BPMN Activity and Resource elements

COM3015 A Message is not referenced by Message Flow
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Error code is not specified for an Error or Error is not defined for an Error End Event
5.2 Error code is not specified for an Error or Error is 
not defined for an Error End Event 
Abbreviation

COM3002

Description

An Error Code is not specified for an Error that is defined (or Error is not defined) for an Error End Event.

Severity

Warning

Context Element

Error End Event

Solution

Create an Error element and specify the Error Code for it. The created Error Create element must be defined for 
an Error End Event.

5.3 Too few outgoing Sequence Flow are detected for 
an Event-Based Gateway
Abbreviation

COM3003

Description

Too few outgoing Sequence Flows are detected for an Event-Based Gateway. An Event-Based Gateway should 
have two or more outgoing Sequence Flows.

Severity

Warning

Context Element

Event-Based Gateway

Solution

Create two or more outgoing sequence flows for validated Event-Based Gateway.
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A Start Event is not defined for an Event SubProcess
5.4 A Start Event is not defined for an Event 
SubProcess
Abbreviation

COM3004

Description

A Start Event is not defined for an Event SubProcess (a Start Event must be defined within each Event 
SubProcess). 

Severity

Warning

Context Element

Event SubProcess

Solution

Create a Start Event within the validated Event SubProcess. The Start Event must be followed by Sequence 
Flows. 

5.5 An Intermediate Boundary Event does not have 
outgoing Sequence Flow
Abbreviation

COM3005

Description

An Intermediate Boundary Event without outgoing Sequence Flow is detected. An Intermediate Boundary Event 
should have at least one outgoing Sequence Flow.

Severity

Warning

Context Element

Boundary Event

Solution

Create one more outgoing Sequence Flows for the Intermediate Boundary Event.
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Incoming/outgoing Sequence Flow is missing for an Intermediate Catch Event
5.6 Incoming/outgoing Sequence Flow is missing for 
an Intermediate Catch Event
Abbreviation

COM3006

Description

Incoming/outgoing Sequence Flow is missing for an Intermediate Catch Event. An Intermediate Catch Event 
should have both (incoming and outgoing) Sequence Flows.

Severity

Warning

Context Element

Intermediate Catch Event

Solution

Create the missing outgoing or incoming Sequence Flow for the validated Intermediate Catch Event. An 
Intermediate Catch Event should have both (incoming and outgoing) Sequence Flows. 

5.7 Incoming/outgoing Sequence Flow is missing for 
an Intermediate Throw Event
Abbreviation

COM3007

Description

Incoming/outgoing Sequence Flow is missing for an Intermediate Throw Event. An Intermediate Throw Event 
should have both (incoming and outgoing) Sequence Flows.

Severity

Warning

Context Element

Intermediate Throw Event

Solution

Create a missing outgoing or incoming Sequence Flow for the validated Intermediate Throw Event. An 
Intermediate Throw Event should have both (incoming and outgoing) Sequence Flows.
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Outgoing Sequence Flow is not defined for a Start Event
5.8 Outgoing Sequence Flow is not defined for a Start 
Event
Abbreviation

COM3008

Description

Outgoing Sequence Flow is not defined for a Start Event. Each Start Event should have at least one outgoing 
Sequence Flow. 

Severity

Warning

Context Element

Start Event

Solution

Create outgoing Sequence Flow for the validated Start Event. Each Start Event should have at least one outgoing 
Sequence Flow. 

5.9 Resource is not defined for a Task
Abbreviation

COM3009

Description

Resource is not defined for a Task. Task should have a defined Resource.

Severity

Warning

Context Element

Task

Solution

Define a Resource for the validated Task. 
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Incoming/outgoing Sequence Flow is missing for a Task
5.10 Incoming/outgoing Sequence Flow is missing 
for a Task
Abbreviation

COM3010

Description

Incoming/outgoing Sequence Flow is missing for a Task. A Task that is not defined within an Ad Hoc SubProcess 
should have incoming and outgoing Sequence Flows. 

Severity

Warning

Context Element

Task

Solution

Create an incoming/outgoing Sequence Flow for a validated Task. 

5.11 Name is not defined for a Task
Abbreviation

COM3011

Description

Name is missing for the Task element. It is recommended to name all Task elements.

Severity

Warning

Context Element

Task

Solution

Specify name for each task.
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Type is not defined for a Data Object, Data Input, Data Output and Data Store
5.12 Type is not defined for a Data Object, Data Input, 
Data Output and Data Store
Abbreviation

COM3012

Description

A Type is missing. Each Data Object, Data Input, Data Output, and Data Store elements should have assigned 
Type.

Severity

Warning 

Context Element

Data Object, Data Input, Data Output, Data Store

Solution

Assign type for the Data Object, Data Input, Data Output, and Data Store elements. Data Object with assigned 
Type can be created automatically by dropping a class element into Business Process diagram.

5.13 A Representer is not specified for a Lane
Abbreviation

COM3013

Description

Representer is missing for a Lane. Each Lane should have specified Resource as Lane Representer.

Severity

Warning

Context Element

Lane

Solution

Use a smart manipulator of a Lane to select a Resource as Lane Representer.
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A Documentation is not specified for a BPMN Activity and Resource elements
5.14 A Documentation is not specified for a BPMN 
Activity and Resource elements
Abbreviation

COM3014

Description

Documentation is missing. Each BPMN activity and Resource element should be documented in the model. 
Element documentation is used for model reports.

Severity

Info

Context Element

Task, Call Activity, Resource

Solution

Specify the documentation for the validated elements. Documentation is widely used in generated model reports. 

5.15 A Message is not referenced by Message Flow
Abbreviation

COM3015

Description

A Message is missing. Each Message Flow relationship should reference a Message.  

Severity

Warning

Context Element

Message Flow

Solution

Assign a Message for the validated Message Flow. A Message can be assigned using smart manipulator on a 
Message Flow or in the Message Flow specification dialog.
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